Digital Pathways Video Curriculum
BAVC's Digital Pathways Video Curriculum is designed to introduce the tools of media production and
analysis through creative and socially relevant visual storytelling. Through the creation of two video stories,
students complete every phase of filmmaking: storyboarding, directing, shooting, and editing on Final Cut
Pro. Our goal is to nurture the talents, skills, and development of young people, and we respect the
experience and perspective that each young person brings to the program.
Unit 1: Getting Started and Basic Filmmaking Concepts
Unit 2: Personal Narratives
Unit 3: Pre-Production
Unit 4: Production
Unit 5: Post-Production
Unit 6: Telling Community Stories
Unit 7: Advanced Pre-Production Skills
Unit 8: Advanced Production Skills
Unit 9: Making An Impact With Your Media

VIDEO CURRICULUM: UNIT 1
Unit 1: Getting Started and Basic Filmmaking Concepts
Ice Breakers
YouthLink begins with class cohesion exercises to introduce students to one another, and to increase their
comfort level. These exercises, also known as “ice-breakers,” can be used throughout the first couple of
weeks to encourage class bonding.
Examples of ice breakers can be found here:
http://www.teach-nology.com/ideas/ice_breakers/
http://adulted.about.com/od/icebreakers/Educational_Icebreakers.htm

Community Agreements
Along with class cohesion activities, we always start our programs by creating Community Agreements,
which are designed to create a safe and respectful space for all, and to encourage students to think of
themselves as a team. Students create community agreements within the classroom to lay the ground rules
for the way that they want to treat each other and work together. In order to decide on our community
agreements, each student writes 1 – 3 post-it notes which describe the rules of behavior they would like their
peers to follow in class. Examples may include “No put-downs,” “Don’t talk while others are talking,” and
“Step up, step down.” Depending on the students’ comfort level, the instructor may want to have students

state their requests out loud as opposed to writing them down. After all requests are made, they are
compiled on a poster, reviewed and discussed, and hung in the classroom for the duration of the program.
An example of a set of community agreements can be found here:
http://lyric.org/safety.html

Program Standards
Instructors introduce Program Standards on the first day of class. These standards describe what instructors
will be teaching and modeling, and what we will expect from students in return. The standards are broken
down into three categories: Creative Standards, Technical Standards, and Critical Skills Standards.
Creative Standards Handout (4.56 kB)
Technical Standards Handout (4.88 kB)
Critical Skills Handout (5.28 kB)
Because students are eager to use equipment immediately, instructors begin using hands-on production
exercises right away. An example of a hands-on exercise is called One-Shot Portraits, and can be found in
the handouts section. This exercise introduces students to equipment, starts the process of collaboration,
and helps students to get to know one another.

Lessons
Our first week of class also includes an in-depth lecture on the technical aspects of the video camera, as
well as a lesson on composition and camera angles. We also cover sound production, basic storytelling
structure, and begin creating a common language with which to talk about the films we watch and make. As
the class progresses, students are expected to become more critical and sophisticated in their ability to
analyze media. This includes an increase in understanding of how style contributes to message, the ability
to analyze a filmmaker’s editing choices, and a knowledge of the many different types of story structures that
filmmakers use.
Unit 1: Camera Angles, Movement and Composition
Objectives
● Students will be able to identify and use camera angles, movement, and perspective.
●

Students will be able to compose a well-balanced picture.

●

Students will learn camera positions that will help them create a unique look that supports their
story’s point of view.

Materials / Equipment
1. Video cameras for instructor and students
2. TV monitor
Handouts
Shot Identification Handout
Exploring a Space (5.35 kB)
Preparation
Hook up the teacher’s video camera to the TV monitor.

Lesson
Call students up to demonstrate principles.
Framing and Composition
When we look through the viewfinder, what do we look for? What makes a good picture? Composition is the
act of composing the image in the viewfinder. It is a visual process of organizing the elements of a scene
into a balanced arrangement that’s pleasing to the eye. Over the years, people have analyzed works that
were perceived to have good composition, and found trends and patterns that emerged. These are called
rules of composition, and they are guidelines to follow. As you become familiar with these rules, you can
think about times when you may want to break them. There are many compositional guidelines, we will talk
about a few.
The rule of thirds
The rule states that an image can be divided into nine equal parts by two equally-spaced horizontal lines
and two equally-spaced vertical lines. The four points formed by the intersections of these lines can be used
to align features in the frame. The rule of thirds can be applied by lining up subjects with the guiding lines.
Draw this out for the students.
Show images. An example from the internet is:
http://www.tv-handbook.com/Composition%20and%20Camera%20Movement.html

Some other examples:
http://photographytips.com/page.cfm/6
http://www.picturecorrect.com/photographytips/composition.htm
http://www.colorpilot.com/comp_rules.html

Head room and nose room
Head room refers to the space between the top of the subject's head and the top of the frame. The subject
should be framed with the appropriate amount of head room. Nose room refers to the space between the
edge of the subject’s face and the frame. If the subject is looking towards the right frame, leave more room
at the right. If the subject is gesturing towards the left frame, leave more room at the left.
Show images.
One example of a time when you may want to break these rules is to convey meaning in your shots. The
way you shoot and compose contributes to the meaning of your piece.
Subject to Camera Distance
What are these shots for? How do they create meaning?
1. Establishing Shot Wide Shot
2. Long shot
3. Medium Shot (MS)
4. Close Up (CU)
Extreme Close Up (ECU/XCU)

Show examples.
Extreme Close Up – “XCU” The Extreme Close Up is a great way to show crucial detail that must be seen to
communicate.
Perspectives and angles
What are these shots for? How do they create meaning? Why might you want to break a rule of composition
in order to create meaning in your
story?
Demo the following angles:
1. low angle
2. high angle
3. level angle
4. dutch angle
5. focus and;
6. rack focus
Camera Movement
Demo the following camera movements:
Moving the camera:
1. Panning – Moving the camera to the left or to the right
2. Tilting - Moving the camera up and down
3. Zooming –Using the camera mechanism to get closer to a subject. Zooming can draw attention to a
subject, and an also reveal information.
4. 5. The disadvantages to zooming are:
1. The picture looks flat
2. Accurate visual perspective is lost
Moving your body with the camera:
1. Dollying – Moving your body with the camera to get closer to the subject (“dollying in” or further from the
subject (“dollying out.” Camera operators can dolly with their bodies, or can use a device with wheels onto
which the camera is mounted.
2. Tracking – Moving your body with the camera while the subject is moving, or following the action of a
subject.
3. 4. The advantage to moving your body with the camera are:
1. Control over the velocity of the movement
2. The dynamic quality of the movement
3. Maintaining a sense of depth in the picture
4. A more accurate visual perspective
Hand Held versus Tripod mounted cameras
When a shot needs to be steady, using a tripod is essential. When a shot requires being in the middle of the
action, holding the camera by hand
can be an effective technique.
Even if you are shooting hand held, you are going to want to keep the picture as steady as possible.
Techniques to steady hand held shooting nclude bracing yourself against a wall, holding the camera low to
the ground, and creating a makeshift tripod with your elbows.

Activity
Shot Identification
After you have reviewed camera angles, movement, and composition, have students practice identifying
these shots in a film.
A piece that includes many different types of shots is Inertia, by Erica Eng (10 min 30 sec, 2004) - Dance
becomes the language of rebellion for some bored high school students.
Distribute the Camera Shot Analysis Handout. Have students watch the film once, and then again. The
second time, ask them to shout out the names of various camera angles and movement.
After they watch the video the second time, lead a discussion about how the shots, angles and camera
movements helped move the story along and convey specific themes.

Exploring a Space
Students divide into 2 groups and each group documents a space in 5-10 shots using the following
guidelines:
1. Practice the camera technical skills
2. Use a variety of camera angles, movement, and subject to camera distance
3. Document not only what the space looks like, but also what it feels like, using your image composition
symbolically and metaphorically
Links to Other Media Examples
California Telephone by Haruko Tanaka (3 minutes)
"California Telephone" is a portrait of a group of seven women and men playing the game commonly known
as ‘telephone’. In California Telephone the messages are lines of poetry excerpted from the work of the late
June Jordan (1936-2002)- poet, novelist, essayist and political activist. The film attempts to speak and listen
between the lines of June Jordan’s words of resistance and insistence.
http://www.kissoftheworld.net/projects/filmvideo.html

BAVC MEDIA EXAMPLES
"Slip of the Tongue" by Karen Lum
Careful what you ask a stranger at the bus stop- you might just get an answer! A look at perceptions of
beauty, ethnicity, and body image (4 min 5 sec).
"Lovebirds: The Story of Rose and James Jones" by Jazmin Jones
An elderly couple's story of growing up in South set against the images of their current Northern California
home records the lush landscape of their lives and their lovebird melody. Created by Jazmin Jones (2
minutes, 58 seconds).
Unit 1: Sound Basics and Recording Techniques
Objectives
Students will be introduced to the basics of sound, microphones and field recording.

Materials/Equipment
1. Lavalier Microphone
2. Shotgun Microphone
3. Boom Pole
Handouts
Recording Sound (8.17 kB)
Lesson
Sound
Definition: Sound is an invisible vibration. It travels in waves, spreading outwards from the source of the
sound. Sounds are different both in loudness and pitch, often known as frequency. Loudness is measured in
decibels (dB).
Pitch / Frequency is measured in Hertz (Hz). All sounds are made up of different frequencies. We can
describe this as the pitch of a sound. The frequency of a sound affects the pitch that it is heard at. The
sound a whistle makes when it’s blown is an example of a high frequency pitch whereas the noise made
when banging on a drum is an example of a low frequency pitch.
http://www.idcs.info/childhood_deafness/what_is_sound.html
Not only is sound half your video, sometimes sound makes or breaks a video.
It is important to know how to record sound technically, and then also how to listen for sounds that can work
creatively to enhance your story.
Types of Audio you will be Recording
Generally, Sound for your video will include the following: Dialogue or Voice Over, Ambiance, Sound Effects
and Music. You will need to record all of this audio and then assemble your sound design (what kinds of
audio will be part of the video sound) and then refine your sound mix (the levels each audio element will be
heard in general and in relation to each other). Refer to Sound Design Lessons for more on Sound Design
and Mixing.
Selecting the Proper Mic:
Use an external mic whenever you can. This lets you have more control over how and what you record.
Microphones come in a variety of types. They can be directional or omni-directional, have their own battery
source or require power from the camera etc. In addition, each make and model has its own character. With
any mic, always listen with headphones to confirm you are recording the sound you want. You can always
reposition the mic to get what you want!
Connect each type of mic to the camera and listen to what audio is picked up.
Lavalier Mic (Lav)
Typical Use: Interviews

Characteristics: These are the small “bud” microphones that can fasten to clothing. Although these mics are
“omni-directional”, they are specially designed to pick up the voice vibration/sounds of a person speaking. It
does not matter where the Lav is placed, as long as it is in the general chest area (collar or front of shirt).
Tips: Try to hide the lavalier or at least the wire under the clothes. (If you hear a rustle through the
headphones, the lavalier chord may need to be taped to the person’s skin.) Place as close to the sternum
as possible. A lavalier likes to hear the resonation in the chest cavity.
NOTE: Each interview subject needs their own lav mic. If you have more than one interview subject and only
one lav mic, use a shotgun mic on a boom pole instead and move the boom accordingly.
Shotgun Mic (also known as boom or stick)
Typical Use: Multiple Interview Subjects, Specific Sound, Ambient Sounds,
Characteristics: Shotgun mics are usually much more sensitive than an on-camera mic, and pick up better
sound. Shotgun mics are directional mics and usually pick up sound in the direction the mic is pointed.
Where you point the mic matters! Tips: For interview: Aim the shotgun mic like a gun directly at the subject.
Bring the mic in as close as possible to the subject using a boom pole, pistol grip or stand. Overhead is
usually safest, though sometimes from under the subject is preferable, depending on the framing of the shot.
Be sure the mic is pointing in the same direction as their path of speech- not to their nose or to the side.
To record general sounds with a shotgun mic, since the mic is directional, aim the mic in the direction of the
sound you want to forefront. For example, if you are at a park and there are kids playing to the right and a
fountain to the left, the side you point it to will highlight one sound over the other (to the right you will hear
more of the kids, to the left, more of the fountain, upright a combo of both and whatever is in the sky).
NOTE: If you are recording general ambiance, if you have access to an external omni-directional mic, use
that. If not, you can cheat it with a shotgun, by pointing the shotgun in a direction in between sounds and
listening with headphones to see if you get what you want.
Omni Directional Mic
Typical Use: For general ambiance.
Characteristics: Omni-Directional Mics pick up sounds from all directions, hence it is good for getting general
(non specific) sounds.
Tips: Point the mic in the any direction, listen with headphones and hear if this is what you want. If not,
reposition the mic accordingly.
On-Camera Built In Mic
Typical Use: Used to record audio when there is no external mic.
Characteristics: Omni-Directional. Note: Since this Mic is omni directional, it picks up sounds from all
around, sometimes including the hum of the camera. If you have access to an external mic, it is always
better to use the external mic so you can have more control and discretion for the audio you record.
Recording Sound Techniques
Basic Checks

1. Is your external mic properly connected to the camera?
2. Is the external mic power on (and the camera extra source power off)? Or vice versa. Select one power
source so you do not short circuit the camera or mic with multiple power sources!
3. Are your audio levels set? Is the audio level high enough, but not in the red?
NOTE: If you are interviewing someone, set up all your equipment and then have your subject say a few
sentences so you can meter your level and set the audio levels to match the level of their voice. Then start
recording the interview.
Use your eyes and ears.
Use your eyes. Watch for the boom, microphone, shadow, or boom operator in the shot! It helps to show
the boom operator where the edge of the frame is, i.e. when any of these things creep into the shot.
Use your ears. While shooting, someone should always be monitoring the sound. If this person closes his
or her eyes, or looks away from the scene, it may help him or her concentrate on the sound. Listen
especially for excessive sound.
Excessive Sounds: Sometimes there are sounds in the setting in addition to what you are trying to record.
Sometimes this is ok, other times this is distracting. Listen to the situation and if it will be too distracting,
move your location or wait until the sound stops. Some “excessive” sound elements to listen for:
Bus Lines/Traffic
Construction; Hum of Computers/Refrigerators
Street Noise; Ventilation Systems
Garbage/ Recycling Activity; Fluorescent Lights
Airplanes Traffic; Actual space: Echo, Dead or Live
Wind
Getting the sound you want and how you want it
Although there is a fair amount you can do with your sound in the post production stage, there are some
variables you need to consider in the production stage. If there is a particular sound you are trying to capture
– for example, the sound of a particular person or object - you need to make sure the mic is pointed at your
desired primary sound element. You must also consider how close or far you are from the sound you are
trying to capture.
Record room tone and ambient sound
Room tone is the sound of your location when all the subjects and crew hold still and silence is recorded. It
has a sound to it.
Ambient sound is the same thing, but more commonly refers to outdoor sounds, the background sound of
your location.
Always record at least 30 seconds to one minute of these without cast or crew making any noise, but
remaining on location.

Blank audio tracks do not sound the same as silence! In editing you may need these crucial audio clips to
replace unwanted sounds or fill in “sound gaps” in your edit.
Note about Ambient sounds: Are there other ambient sounds in the environment you could record that may
be used as part of your sound design later?
Activity
Have students tell the story of a place by recording sounds that convey the sense of the place. They can
shoot visuals that symbolically/metaphorically support the sound. Note: This is an exercise not only in
documentation of a place, but also selecting a perspective and story to tell about the place.
Unit 1: Story Arc

Objectives
Students will be able to understand and identify the basic structure of a story.
Students will be able to plot out their favorite stories/movies onto an arc and see how the arc can be used.
Students will be able to use the arc to map out their own stories.
Materials / Equipment
1. Paper and pens
2. Whiteboard
Handouts
1. Story Arc (74.3 kB)
Lesson
Distribute the Story Arc Handout. Explain that story structure can take many forms. In general, stories have
a beginning, middle, and end, with movement and points of conflict throughout the story. Today we will be
thinking about a structure of setup, conflict, and resolution. Over the course of the session, we will also be
looking at media that does not follow this model.
Review a media example and identify the Beginning (Setup), Middle (Conflict), and End (Resolution).
Recommended pieces include: "Living In A Peaceless Community" by Stephan Bowers, and "Outside The
Box" by Kate Blaine-LaTerre.
Break down Setup (Beginning)
Who/what/when/where/why/how?
Break down Conflict (Middle)
a. Who is looking for something, or wanting something?
b. What is the struggle?
c. Why is this story being told? What is the message?
Break down Resolution (End)

d. How does the conflict get resolved?
e. Does the character get what they want/need?
f. How is the impact of the story on the audience?
Identifying transformation (End)
g. Who has changed as a result of this story?
h. What has changed as a result of this story?
i. How has the person or situation changed because of the story?
BAVC Media Examples
"Living in a Peaceless Community" by Stephan Bowers
Living in a Peaceless Community tells the story of life before and after beef started in Hunter's Point.
Created by Stephen Bowers (7 minutes, 7 seconds).
"Outside The Box" by Kate Blaine-LaTerre
A teenage girl's story of her struggles dealing with her learning disability and how she found ways to cope.
Created by Kate Blaine-LaTerre (3 min 17 seconds).
Activity: Exploring Conflict
What is conflict? There are many different types of conflict:
1. Physical conflict (fighting)
2. Emotional conflict (argument)
3. Natural conflict (forces of nature)
4. Conflict of ideas (debate, politics)
5. Conflict of emotions (internal conflict – do I tell my best friend I think he/she is wrong?)
6. List a couple of the most popular movies of recent years and have students identify the conflict. There
are many short films that can be used to demonstrate what conflict is. Resources for films can be found
online at:
1. www.atomfilms.com
2. www.pbs.org/independentlens
Break students into groups and give each group a conflict to use in a story.
Example conflicts to provide:
a. They try to answer a ringing phone but when they pick it up, it still rings.
b. Candy won’t come out of a vending machine
c. 2 people want 1 cookie
Each group must create the beginning of the story and provide a resolution (conclusion) to the story.
Students create scripts or storyboards for their stories - IE:
a. Joe walks to vending machine
b. Joe puts money in vending machine
c. Joe pushes button on vending machine
d. Vending machine won’t give out money
e. Joe looks angry
f. Joe hits vending machine Etc…

After writing or drawing out the stories, students must create shot lists – IE:
a. A shot of Joe walking up to vending machine
b. A shot of Joe putting money into vending machine
c. A shot of Joe pushing button on vending machine
d. A shot of bag of candy not dropping
e. A shot of Joe looking angry
f. A shot of Joe hitting vending machine
Etc…
After completing the scripts and shot lists, students must shoot their film according to what they planned on
paper. They should shoot in order, also known as “editing in camera”. Allow them to make changes if
circumstances aren’t what they thought they would be while shooting. Students cannot watch what they just
recorded until they are finished.
Students come back together watch completed pieces. Have a discussion on what worked and what didn’t
work technologically and artistically.
Unit 1: Creating a Common Film Language
Objectives
Students will understand the model with which to critically view and analyze a film.
Students will understand how to analyze the structure and arc of a story.
Students will be able to use this model to talk about the media that they view.
Students will be able to apply this model to the media they make and explain and support their story
structure, style, themes and edit decisions.
Handouts
1. Critical Skills Handout (5.28 kB)
2. SCMAA Handout (5.11 kB)
3. Story Arc (74.3 kB)
Lesson
Pass out the Critical Skills handout to remind students of the media analysis skills they will be building
during the course of the session.
Lead a brief discussion.
What do you think makes a good film? When you watch films, what do you look for?
When you talk to a friend about a film you just saw, what do you talk about?
In the world of film critique, there are established elements that people consider when looking at and talking
about film. We’ve organized these elements for you and we’re going to present these as a common
language we can use. We can use this language when we’re analyzing film, when we’re talking about it, and
also when we’re looking at each other’s pieces and giving and receiving feedback.

The elements we’re presenting today can also serve as tools that you can use to figure out what qualities to
look at when you’re making your own pieces.
Hand out the SCMAA handout.
Take students through each letter in the “SCMAA” and what is stands for:
1. What is the Story?
2. What is the Conflict/Driving force?
3. What is the Message/Idea/Theme?
4. Who is the Audience?
5. What are the Aesthetic choices made by the filmmaker?
Watch a piece of media with students and guide them through the SCMAA and story arc for the piece. Try to
use pieces that vary in theme, structure, and style.
As you map out the story arc, start with the beginning, middle, and end. Talk about what drives the piece,
where the movement happens, where the points of conflict are, and if there are any shifts in perspective.
Does the style change? Where and why? Does the sound design change? Where and why? Talk about how
the arc ties into the story and the message. Discuss the varying story structures that filmmakers can employ
when creating a piece.
Hand out the SCMAA worksheet. This worksheet can be used to guide students through the process of
analyzing a film’s elements. Students should use the story arc to map out the plot points, the points of
tension or conflict, and the aesthetic choices and shifts.
Activity
Break students up into groups to view pieces. Have them fill out the SCMAA Worksheet, including the story
arc, for the piece they are viewing.
Have each group present their piece to the class, using the SCMAA model to explain and analyze the piece.
Media Examples
Note About Media Examples Provided and Referenced: The films and videos listed below are diverse
examples of storytelling techniques, story structure and how and why conflict is produced in a story to move
the story forward, give the story multiple, complex levels and connection to larger social issues. The list
below is not meant to be comprehensive. We have tried to give examples from a variety of genres to show
that all videos, whether they be dramatic narratives, documentary, spoken word or experimental all share
certain elements of storytelling. Use the SCMAA and StoryArc worksheets to analyze the following films. We
have made some notations below to help guide you in this process.
"Slip of the Tongue" by Karen Lum (4 min 2005)
A young woman schools a young stranger on his assumptions about ethnicity and beauty.
Youth Produced- yes
Affiliated Program/Producer: BAVC Next Generation Video Factory Program
Genre: Spoken Word/PoetryStory

• Story – Links “Personal” Incident to a larger social issues (gender, beauty culture, race)
• Shifting POV (point of view) Conflict
• Multiple Conflicts on level of narrative and interpersonal storyAudience
• Addressed to multiple audiences- interesting to analyze what it means to different audiences (age,
gender)Aesthetic
• Strong Fast Paced Visual Storytelling to compliment and expand fast paced sound (spoken word)Editing
• Fast cuts
• Shifting audiovisual relationship (demonstrative of ironic to complex)
• Variety of camera angles, movement and composition
"Calicot" by V. Sarah Gurevick (6 min 40 sec, 2003)
A short dramatic narrative that traces the picking of cotton to its final destination.
Youth Produced - No
Producer: V. Sarah Gurevick
Genre: Short Dramatic Narrative Story
• Story: Narrative engages social issues and history...labor issues, global connections,
immigration/migration, history, civil rights and racism
• Conflict: Non-traditional conflict which opens up dialogue multiple social issues
• Aesthetic: Strong Visual Storytelling with minimal to no dialogue (has sound)Editing
• Editing: connects time/space and tells the story
"Nigger" by Jermaine Williams (5 min 30 sec)
A word of hate or term of endearment? Like many young African American teens, Jermaine used the word
every day. Then, in the summer of 2003, he traveled down south and met people for whom nigger will never
be just another word.
Youth Produced- yes
Producer: HBO Young Filmmakers Lab/ Reel Works Teen Filmmaking
Genre: Documentary
•Story: Story systemically explores the definition, history and opinions of the N-word; good, traditional
example of how a issue is structured and explored
•Video laid out in a way that propels the story logically forward
•Story told by Interviews, B-roll and archival footage
•Aesthetic: Traditional Talking Head Issue Based Documentary
•Uses Interviews, B-Roll, Historical/Archival footage to present information as testimonials, facts and
opinions
•Interviews function as testimonials.
•Variety of Interview subjects.
•Interview subject background set design appropriate to subject being interviewed.
•B-roll and Archival media to supplement interviews
•For the most part narrator is invisible until the end.
"I Promise Africa" by Jerry Henry (2 min 40 sec)
The voices of a group of young Kenyans are silenced by AIDS
Youth Produced: No
Producer: Jerry Henry

Genre: Documentary/Public Service Announcement Story
• Story: Story connected to a larger social issues (AIDS, personal responsibility, nation)
• Notice how and when and what story information is revealed
• Conflict: Non-Traditional Conflict Audience
• How is audience defined by situating a context of this story in relation to 9/11/01?
• Aesthetic: Use of Still images, text and music to tell the story
• Shifting audio/visual relationship
• Editing: Use of slow motion and sound/image disconnect to heighten conflict
"The Apollos" by Jazmin Jones and Nick Parker (6 min 2006)
The 1981 Oakland Tech High School senior class fought to make MLK day a nationally recognized holiday.
The story of the Apollos is a story of those who reach beyond the stars.
Youth Produced- yes
Producer: BAVC Next Generation Video YouthLink Program
Genre: Documentary
•Story: Three character interviews interwoven to tell the story
•Interweaves multiple themes: connections between past and present, history, intergenerational dialogue,
civil rights, activism, use of fair use law
•Aesthetic: Traditional Talking Head Issue Based Documentary
•Uses Interviews, Historical/Archival footage to present information as testimonials
•Interviews
•Variety of Interview subjects (Intergenerational)
•Interviews function as testimonials
•Interviews presented in an anecdotal manner
•Three character interviews interwoven to tell the story, each interviewee presents a different element of the
story
•Archival media to supplement interviews- Use of newspaper clippings exercises Fair Use Law
VIDEO CURRICULUM: UNIT 2
Unit 2: Personal Narrative Projects
We teach from the belief that young people have the ability and the right to tell their own stories, and that
telling these stories can be a transformative experience for many young people. Many students apply to
BAVC's programs with stories burning inside of them. For this reason, students create Personal Narrative
projects in the Beginning session of the class. These are 3 – 5 minute pieces that have personal meaning to
the students. Students become invested in their projects and motivated to tell their stories, which creates a
strong sense of project ownership and opens up opportunities for effective teaching of technical skills and
storytelling skills.
Common topics for Personal Narratives include neighborhood violence, stereotypes, teen parents, identity,
and exploration of family issues. Within their topics, students must identify what the story is, what the conflict
is, what the message is, who the audience is, and what they style of the project will be.
Although students work on these pieces as solo artists, they receive a great deal of feedback along the way.
We build in time for feedback from the instructor, as well as from the T.A. and classmates. Students also
participate in a Rough Cut and Final Cut Panel, where media professionals give them comments and
suggestions about their work.

Unit 2: Exploring Personal Narrative Filmmaking
Objectives
Students will understand that there are various methods and styles a filmmaker can use to tell a personal
narrative.
Lesson
There are many styles and approaches to personal narrative filmmaking. In this lesson we have compiled a
list of personal narratives that range in topic, style and approach.
For each film, use the SCMAA and Story Arc worksheets to aid in the film analysis.
• Portraits from Within
• Stories about Identity
BAVC Media Examples
"I Ball by Chris Vargas"
What is passion and how does it influence someone’s life? I ball, you ball, this is Chris’s story about what
basketball means in his life (4 minutes, 7 seconds).
VIDEO CURRICULUM: UNIT 3
Unit 3: Pre-Production

Students often come into the YouthLink program knowing a story they would like to tell. During the
pre-production stage, instructors introduce writing and brainstorming exercises to help students get story
ideas down on paper. Once students know the topic they would like to make their first project about,
students pitch their ideas to the class, which helps them to clarify message, audience, and style.
Thinking about audience can be initially challenging for students – they tend to say “this film is for everyone.”
We encourage students to narrow their focus to a particular audience – for example,
teenagers/parents/people from a certain neighborhood. Knowing the audience will affect the piece’s
approach, message, and style.
It is also especially helpful for students to stay clear on the message of the piece throughout the filmmaking
process. This clarity will help keep students focused on what their initial reasons were for doing the piece.
While pre-production is an essential part of the filmmaking process, it is often the most tedious. Many
students want to start shooting without preparation. YouthLink instructors encourage students to do as much
preparation as possible to ensure a well-planned and successful shoot. Instructors work with students to
create storyboards and shot lists so that when students begin shooting, they know what shots they are
looking for and how to get them.
Remind students about the Creative Standards and Technical Standards handouts, and that they should be
trying their best to get high-quality footage that supports their stories.

Unit 3: Story Webbing

A story web is a free association exercise that helps get digital story ideas flowing. By beginning with a
broader topic, branching out, then narrowing to specific “threads” or concepts, the story web will help
students identify themes, variations, and elements of their stories. Story webbing is best with two people:
one is the storyteller, another to be the storywebber (questioner/writer). Story webbing is done after the
student has already brainstormed some topics that s/he would like to make a film about.
Objectives
Students will open up their topic to associations and then narrow in on the topic and the story.
Students will be able to think of new ways to help visually represent the ideas they intend to communicate
(beginning a shot list).
Students will understand how to use free association to brainstorm ideas.
Materials / Equipment
• Huge Post It notes and a marker
• White board to demonstrate free association/brainstorm.
Lesson: Story web demo
A story web is a free association exercise that helps get digital story ideas flowing. By beginning with a
broader topic, branching out, then narrowing to specific “threads” or concepts, the story web will help
students identify themes, variations, and elements of their stories. Story webbing is best with two people:
one is the storyteller, another to be the storywebber (questioner/writer). Story webbing is done after the
student has already brainstormed some topics that s/he would like to make a video about.
If a Teacher’s Assistant or Co-Teacher is available, do a demonstration of a free association exercise. If not,
pick a willing student and work on a free association with them.
Rules
1. Criticism and judgment are not permitted during the brainstorming time. There is no right or wrong
answer; there is no good or bad idea. Review of the associations will come later.
2. Wild is permitted. The wilder and stranger the association, the better. Many times a great idea can come
from a wilder one.
3. Write everything down. Don’t just have people call out their ideas. If the ideas are not written down,
people will forget what was said. Sometimes looking at an idea can spur more ideas.
How-to
Stage One
Webber asks storyteller for the broad topic that overarches their story, and writes it in the middle of page 1.
(Examples: family, violence, identity immigration, home, love).
Webber asks storyteller to free-associate things related to the broad topic, and draws lines out from the
center topic to the freely associated topics. Themes can usually be presented by drawing out a path from
the main subject (center of the diagram) out to a periphery.

If other ideas emerge, the webber should write them down. Related ideas can be clustered visually on the
page.
Stage Two
The storywebber asks the storyteller to look at stage 1, and asks, “which of these topics stand out to you?”
or “which interest you the most?” The storywebber then transfers four or five of these to quadrants of Page
2.
The storywebber begins to ask more questions to draw out specific thoughts and memories related to the
topics. When asking questions, be specific about asking:
1. What are the feelings?
2. What are the senses (sight/touch/hearing/smell /tastes
3. What is the issue?
4. What caused the change?
5. What was the challenge?
Stage Three
Using similar questions from Stage 2, the webber asks the storyteller to describe more about their thoughts
and memories from Stage 2, and jots down notes. In this section, the main question is, “Any specific
instance or memory that can exemplify their thoughts or feelings on the subject?”
The webber asks the storyteller to relate any stories he/she has about a thought or memory. The webber
should pay close attention to any “sequences” with a beginning, middle, and end, and any “one time…”
sentences, or other story indicators.
The webber puts stars next to the most interesting topics. Starred topics can be expanded to additional
pages.
Stage Four
Review the brainstorming session and look for the themes or ideas that have emerged. Did a few visual
ideas stand out to you? Can you tell a story about it? Circle the storyteller’s favorite thoughts or ideas.
These ideas can be used to inform their story topics and storylines.
Unit 3: Brainstorming About a Story
Objectives
Students will have space and tools to get story ideas on paper.
Materials / Equipment
• Paper and pens.
• Poster with prompts. Examples include:
•
•
•
•
•
•

-What are you afraid of? Why?
-What is something in your life that has changed?
-Describe a personal event that had an impact on you
-Describe a personal belief you have about yourself and/or the world
-Describe a struggle you face, or overcame
-What are you worried about?

•
•
•

-Describe an important decision you made. What happened?
-Think of a time you affected someone else. What happened?
-What are you angry about?

Lesson
Ask students to write 10 story ideas down on their paper. Many students will already have ideas about
personal stories they want to tell. Students may use prompts if they need help getting started.
Have students narrow their ideas down to 3, then choose 1 story to free-write about. Ask them to write on a
topic that they feel passionate about.
For the free write, tell students to write for 5 minutes without picking their pen up from the paper. They
should follow their passion wherever it takes them.
Activity
If students are having difficulty finding story ideas, try one of these activites from the BAVC Brainglow DVD:
Wildcards (see handout) – One side of card has a subject (eg Hair, Religion) and the other side has
questions that explore the subject. Example: TECHNOLOGY –/- Why do you like new technology? Or why
not? What is the greatest invention of all time? Why? If you were asked to patent a new type of
technology, what would you invent?
Plot One Liners – Give students a story starter and have them create the rest of the story. Example: “You
and your friend decide to play a trick on someone, but it backfires.” Or “Two people in different social groups
become unlikely friends when…” Or “A woman was walking her dog through a grassy field when she…”
Interview yourself – One way to generate a story is to ask yourself questions that might spark a memory, a
new idea, or a new way to think about an experience. You’ll realize how many stories you have inside you,
bursting to get out. Answer the following questions, and try to make the answers an anecdote (a memory of
something that happened).
• How would you describe the room where you spend the most time in?
• What do you do everyday?
• What do you enjoy most in what you do everyday?
• What’s the funniest thing you remember?
• Describe the origin of your favorite shirt.
• What’s the most important thing you’ve learned this year?
• Describe your least favorite food.
• Do you have a philosophy about life? If so how did it develop?
• Describe a dream you’ve had.
• Describe someone you miss. What do you miss most about that person?
• If you could travel anywhere in the world, where would you go and why?
NET STANDARDS addressed in this lesson: 3
Unit 3: Pitching a Project
Objectives
Students will be able to present their idea in a cohesive manner to an audience.
Students will be able to discuss their ideas in an open forum and receive feedback.

Students will be able to observe other students’ presentations, take notes, and offer constructive criticism in
the form of questions and suggestions.
Materials / Equipment
• White board for presenter
• Paper and pen for observers
Handouts
The Pitch Worksheet (Beginning) (6.53 kB)
Lesson
A pitch is a rehearsed presentation of a project intended for creation. It is done in the same vein as when
Hollywood/independent producers asking people for money to fund their project.
Students should have completed the pitch worksheet in preparation for their presentation. The pitch covers
the scope of what the piece will be about (the story and the message), who the intended audience is, and
what sort of style the piece will be told in.
One student pitches a project while the instructor and the rest of the class listen. At the end of the class, the
students and the instructor ask questions and give feedback. Make sure that every student participates in
some way. Questions could include clarification about intended message, story, style, visuals, and
practicality.
Unit 3: Creating Storyboards
Objectives
Students will be able to move from a story idea to shot conceptualization.
Materials / Equipment
• Paper and pen
Handouts
From Story to Storyboard (57.77 kB)
Storyboard Template (134.67 kB)
Lesson: Storyboarding
A storyboard is a series of pictures that displays, frame by frame, the layout of the production. A storyboard
should include:
• The shot number
• A sketch and/or description of the video image
• Camera placement
• Subject to camera distance (LS, MS, CU, ECU)
• Camera movement (still, pan, tilt, zoom, handheld vs. tripod)
• Camera angle (low, high, eye level)
• The audio that will accompany the visual (dialogue, music, Foley)

A storyboard acts as a guide for the production stage of producing a video. It helps the director to produce
the shot list, and helps the camera person to compose the shots. The storyboard is also used in postproduction to develop the structure of the finished product.
Activity
To help students take the step from a story idea to creating a storyboard, have them write answers to the
following questions (also included in the storyboarding handout for this lesson).
Part I
Make a list of all the possible “characters” in your film. For example, for a piece about how your cousin is
scared to get deported because of present US immigration legislation, characters may include: cousin, self,
immigration lawyer, family, friends, interviews with people on the street on what they think about the
immigration laws legislation…
For each “character” make lists of the following:
• List of locations/ settings associated with character
• List of visuals (realistic)
• List of visuals (symbolic/metaphorical)
• List of sounds (realistic)
• List of sounds (symbolic/metaphorical)
Part II
Hand out the Storyboard Worksheet. Based on the above, have students storyboard 2 shots that tell
different aspects of their stories (include: sketch/description of image, camera placement, subject to camera
distance, camera movement, camera angle, and audio).
Get into pairs of two. Share your 2 storyboarded shots with your partner and ask them the following for each
shot:
• Can you picture this shot in the film?
• What do you like about it?
• How do you see the shot related to the film?
• Where do you see this shot - in the beginning, middle or end?
• Any suggestions?
Unit 3: Creating Shot Lists
Objectives
Students will be able to create a shooting plan and shooting schedule
Materials / Equipment
• Paper and pen
Handouts
Shot List Handout (5.19 kB)
Logistics Worksheet (4.75 kB)

Lesson: Shot Lists
A shot list is an itemized breakdown of all the shots necessary to tell the story. The following is also included
in the shot list handout for this lesson.
A student wants to shoot a scene of a family eating dinner. A typical shot list might look something like this:
• Close up of an empty dinner plate being filled with food
• Close up of a tuna casserole in a serving dish
• Close up of steam rising from a plate of asparagus
• Medium shot of a person sitting down to eat
• Another medium shot of a person sitting down to eat
• Wide shot of several people sitting down to eat
• Medium shot of a person picking up a fork and serving food
• Medium shot of 2 people eating
• Long shot of family eating dinner
A student wants to do a documentary video about a person who walks dogs at the SPCA as a volunteer. A
typical shot list might look something like this:
• Interview of the Volunteer who walks dogs
• Close up of a dog
• Medium shot of a dog
• Long shot of the halls in the SPCA
• Exterior shot of the SPCA
• Exterior shot of Volunteer walking down street
• Exterior shot of Volunteer walking into SPCA
• Interior shot (medium) of Volunteer entering SPCA
• Interior shot of Volunteer checking in at reception desk
• Medium shot of Volunteer walking down hallway
• Medium shot of Volunteer walking up to cage with dogs
• Medium shot of dogs being excited, and leaving cage
• Close up shot of dog being excited
• Close up shot of cage being opened
Using the shot list worksheet included with this lesson, students should plan their shots, group them by
location, and decide the most appropriate shooting order. Concepts to remember while creating shot lists:
Coverage:
The purpose of getting all these shots is to make sure there is enough footage (coverage) so that when the
editing begins, the editor has enough material to work with. This allows for much more creativity when
editing to tell the story.
B-Roll:
Shots b through n in the 2nd example above are examples of B-roll. This is footage that the editor can cut to
while the interview subject explains what they are doing. This makes for a more dynamic and interesting
video than a simple long take of a person on camera talking (“talking head”).
Shooting Ratio:
A shooting ratio is the amount of video that is shot versus the amount of video that ends up in the finished
product. Always shoot more than you need. There is a typical shooting ratio of 15:1 for many videos, and

for documentaries, this ratio is much higher. A 15:1 ratio means for every 15 minutes of video shot, only 1
minute will wind up on screen. You can imagine for a 1-hour video, over 15 hours was shot.
Activity
Students should prepare their shot lists. After students are done with this task, they should think about who
and what they need for a successful shoot. For each location, students should write down what equipment
and personnel they will need. Students should also make phone calls to schedule a time to interview their
subjects (if any). Have students complete the Logistics Worksheet.
VIDEO CURRICULUM: UNIT 4
Unit 4: Production Intro
During the production stage, students gather footage they will use to tell their stories. Instructors begin this
stage with a discussion of the legal issues that arise as filmmakers gather images. YouthLink students are
not permitted to use commercial music or copyrighted images pulled from the internet. Instructors explain
the legal issues behind these decisions, but also convey that student videos typically turn out to be more
creative and original when images are produced by the student. Students will often ask friends for original
music, or find bands through social networking sites who will give them rights to use their music.
We believe in permitting students to tell their stories through their authentic voice and their own perspective.
We also know that sometimes, the reality of our students’ lives involves participation in illegal activites. While
we encourage students to talk about the truths of their lives, we also discuss the importance of staying safe
during video shoots. Instructors emphasize that students should avoid potentially dangerous situations (eg
videotaping fights or drag races that could potentially be harmful to them.) It is also important for students to
know that it is illegal to videotape unlawful activity. Instructors talk with students about finding alternative
ways to include these issues and activities in their videos without explicitly showing them on screen.
As students begin production, we remind them about technical standards, and provide further instruction to
assist students with technical and compositional proficiency.
Unit 4: Ethical and Legal Issues for Production
Objectives
Students will understand the legal issues regarding release forms and copyright.
Handouts
Release Form (4.38 kB)
License Agreement (6.62 kB)
Discussion
Ethical Issues
As a mediamaker, you will be portraying and representing other people’s stories, and you therefore possess
a great deal of power. It is your responsibility to be true to your subjects, to do your best to represent them
accurately, and to tell their stories fairly.

Give the class some scenarios they might face in their process of filmmaking. How would they resolve these
issues? Discuss as a group.
Some example scenarios could be:
• You are recording a subject who becomes emotional and is embarrassed about it. She/he asks you not
to use the footage in your video, but you think it would contribute nicely to the content. What do you do?
• You discover some music on the internet that would be perfect for your video. You find the name of the
musician and e-mail her to ask permission to use her music, but she never writes back. What do you do?
• You are missing interview footage that supports a main point that you would like to make in your video.
You discover in the editing process that you can manipulate one of the character’s interviews to support this
point, but this changes the nature of what the subject actually said. What do you do?
Legal Issues
The law can help us answer some of these questions. Laws that protect film subjects and artists exist to
protect them from being taken advantage of.
Release Forms: Talent
If you are going to show a person’s face in your video, you need to have them sign a Talent release forms.
If someone happens to step in front of the camera while shooting, a release form will be required. However,
if the face of the person cannot be seen, then a release form is not needed. A sample of a Talent Release
Form is included in the Handouts section.
Copyright
Copyright protection means that the artist who created a piece of art (be it writing, painting, photography,
video, music, sculpture) owns the rights and privileges to display that artwork. No other person can use the
artwork without the express written consent of the artist that created it. Copyright protects artists so that they
can profit off their own work. If someone else takes the work without permission and uses it, the artist can
sue.
Those who want to use a copyrighted piece of artwork will need to contact the artist, or the owner of the
copyright and get permission. Often times getting permission takes a lot of time, and will often cost money.
For most student filmmakers, there is neither time nor money to pursue getting a copyright clearance.
Encourage students to use photographs and music of their own, or ask friends who are artists for permission
to use their work. If you are not the artist, make sure to have the artist fill out a License Agreement.
A sample of a License Agreement is included in the Handouts section.
There are also resources online for images and music which are free to use without copyright. A few
resources include www.creativecommons.org and www.ourmedia.org.
For more information about copyright and clearance issues, especially regarding documentary, check out
The Center For Social Media at www.centerforsocialmedia.org.
NET STANDARDS addressed in this lesson: 4
Unit 4: Interviewing Techniques
Objectives

Students will learn how to prepare for and conduct a basic sit-down interview.
Lesson: Research
In order to ask your interview subject insightful questions, you will need to know as much about the subject
as possible. To prepare for the interview, think about who the subject is, what knowledge or expertise they
have, and what role they are playing in your video. What answers will you be able to use to further your
story? You can also get more information on your subject on the internet.
Interview Setup
Before doing the interview:
Make sure the chairs that the interviewer and interviewee do not have wheels or swivel. A nervous person
on a swivel chair will rock back and forth, which will be distracting to the viewer.
Make sure to arrive at least 1 hour before the interview subject is to arrive. This will give you time to set up
before the interview subject arrives, and will give you ample time to troubleshoot any issues that may arise
when setting up.
• Set up and test camera
• Set up and test sound
• Set up and test lights
When the interview subject arrives, make sure to thank them and offer them some water.
Starting the Interview
Make sure you do a sound check when the interview subject puts the microphone on. Have your interview
subject count to 10 while you listen to his voice through the headphones. If everyone reports that they are
ready, go ahead and roll camera. Let the camera roll 10 seconds before asking the first question. Start the
interview out by asking the interview subject to say AND SPELL their name. The reason for asking them to
SPELL their name is so that when you are giving them credit in your titles, you know you have the correct
spelling of their name. Nothing is worse than having your talent’s name misspelled in your video’s credits.
Asking the interview questions
You will need to give your interview subject some guidance and direction in how to proceed with the
interview. Explain how long the interview will take, the kind of questions you will be asking, and where they
should look (most likely at the interviewer and not at the camera).
Start your interview with simple questions to give the artist time to get comfortable with the camera and
being interviewed:
• What is your name?
• Spell you name.
• Tell me about your work.
Once you have warmed up you can move into the more challenging questions. Questions should be
open-ended so that they can produce informative responses. You should also ask the subject to re-phrase
the question in her/his answer. For example, you can say: “I’m going to ask you ‘What is your favorite color?’
And we want you to answer “My favorite color is…” This will enable you the filmmaker (or your editor) to
eliminate the actual asking of the question as its recorded on tape, and just use the answer of the interview
subject “My favorite color is…”. This needs to be explained to the interview subject. Give your interview
subject at least 2 different examples. Your interview subject will forget, and you will need to ask your

interview subject to re answer the question in the correct format. It is perfectly okay to interrupt the interview
(with apologies of course), and ask the interview subject to re-answer the question again.
A sound bite is identified as a short clip (10-20 seconds) which is pulled from a longer clip. It is the nugget of
the answer/information you are looking for. These sound bites make for interesting editing. If you feel like
you’re not getting the information you were hoping to get, try and rephrase the questions that your interview
subject has not yet successfully answered. Try it 2 or 3 times. If the interview subject still is not giving the
answers you are wanting, then perhaps it’s a good idea to halt the interview and explain the specific
information you are hoping to get.
Pay attention as your interview subject speaks. Take down notes, or have someone take notes for you, to
make note of the subject’s main points. The subject’s answers may bring up new questions or may provide
answers to a question you haven’t asked yet.
Documenting the interviewee
You will be videotaping and photographing during the interview. Visually, this will provide a portrait type
image of the subject. But you will also want to compliment this footage and these images with images the
reveal more information about the subject. These will be used in conjunction with the interview so that the
viewer doesn’t have to always see a “talking head” on the screen. The footage can be as simple as
someone walking up the steps of a building, or unpacking their gear out of a bag, etc. Before you even
arrive at you interview you will want to have a clear idea of the types of images you are looking for. But you
will also be on the lookout for images once you get there that you didn’t consider. You will create a list of the
shots you want before you arrive at the interview and divide the shots up among your group. For example, if
you are interviewing a youth artist, here is a list of ideas of things you might want to plan on documenting:
• Artifacts of the artist (if they are a painter then a can of paintbrushes, if they are dancer the their
costumes or shoes). You are looking for artifacts that symbolize their art form
• A wider shot of the artist in their environment
• The artist at work (performing, producing, writing, etc)
• The artwork (images of their work, performance, etc.)
• Photographs, flyers, awards, etc from past art events, performances, etc.
• Be sure to get close up, medium and wideshots of things on your shot list
• Think about how you will use the image before you photograph or tape it. For example maybe you will
get a close up detail of a costume and use it as a graphic element on a webpage.
• Be creative and have fun with the camera. Experiment!
Activity
In this activity, the instructor will conduct a mock interview with a volunteer student subject. The first time,
the instructor will go about the interview incorrectly, and ask the students what she/he did wrong, and how to
do it better. The instructor will then perform the action again, this time correcting her/his mistakes.
Initial Phone Call
WRONG: Pick up phone and dial. “Hello, George? Hey, I’m making a movie, can I interview you?” (PAUSE
for feedback)
CORRECT: “Hello, may I speak to Mr. President, please? Hello, Mr. President. My name is X, and I am
making a documentary about presidential themes. You have a lot of wisdom to offer he subject, and I would

love to interview you for the movie. Would you be willing to Talk about how effective your first approach is.
Explain that “phone presence” is essential to making a good pitch and a good presentation.
It’s a good idea to call your interview subject just to confirm the time and location of the interview to take
place.
Day Of The Interview
Have your volunteer become The President, and have her/him step out of the room while you are setting up
lights and testing the equipment.
WRONG: As “The President” enters the room, look over and rushedly say “Oh! I wasn’t expecting you so
fast. Uh, just go sit over there and I’ll get you when I need you.” (PAUSE for feedback)
CORRECT: As “The President” enters the room, stop what you are doing with preparations, turn your
attention to the President and walk up to him, shake his hand. “Good afternoon sir, I am so glad you made it.
We will be a few more minutes to set up. Can I get you anything to drink?” Your interview subject is doing
you a favor. They are taking time from their schedule to participate in your movie. You should be ready
when they arrive. Treat your interview subject like you would treat a favorite guest. Ask them if you can get
them some water.
Seating The Subject
WRONG: Invite the President to come into the interview space. Sit the President down on a SWIVELCHAIR.
(PAUSE for feedback)
CORRECT: Sit the President down on a chair that does not swivel.
Explaining the process to your interview subject.
WRONG: “Okay you ready to go?” (PAUSE)
CORRECT: “Have you ever been interviewed before? You have valuable information that we would love to
put into our film, and we are going to ask you some questions. We may ask the same question a few times,
and it may feel repetitive. It is only because we are trying to make sure we get the information we’re looking
to get. Do you have any questions?”
Starting the Interview
WRONG: “Okay. We are ready to begin. What is your first name?”(PAUSE)
CORRECT: “Are you ready? Camera ready? Sound ready?” Make sure the interview subject is ready, and
that you do a sound and camera before you start rolling.
Asking the Interview Questions
WRONG: Did you have fun at the pool today? (PAUSE)
CORRECT: What did you do today and how did you feel about it?
Make sure you ask open-ended questions so that you do not get yes or no answers.
BAVC Media Example
"The Utters" by Jasmin Peraza (3 min)
The band the Utters- who they are and why they make the music they do.

Unit 4: Production
Objectives
To reinforce camera, sound, and compositional techniques as students begin production on their projects
Materials / Equipment
• Camera
• Tripod
• Sound Equipment
• Mini DV Tape
Handouts Shooting Handout (6.59 kB)
Lesson
There are several technical considerations to keep in mind when in production. Here are some basic
reminders before you record:
Insert and cue a tape: If this is a tape you have used before, make sure you see timecode on the screen, or
you may get a timecode break. You may have to cut off 3 seconds of your existing footage in order to avoid
a timecode break.
ND filter: If the camera wants an ND filter (usually in bright sunlight), it will flash at you.
Shutter Speed: Make sure the shutter is set to 1/60.3 or default.
Exposure: First try auto exposure to see what the camera wants. Then, switch the exposure to manual and
use the zebra setting and iris dial to make sure your subject is exposed properly and the lights and darks are
appropriate. The manual exposure setting is better because the exposure won’t fluctuate (manual locks it in
place), and you can make your own adjustments as the light changes.
White balance: White balance should be set manually. You first have to go to the manual white balance
setting. The icon is a little square between two triangles. Next, set the white balance by filling the screen
with a white piece of paper, and pressing and holding the set button (often the scrolling selector).
Focus: Zoom in as close as you can to the subject, focus, and zoom out to your frame.
Lighting: Is there enough light to get a clear picture? Are there shadows or glares? Is your subject backlit?
Do you need a reflector to add in a little more light?
Frame your shot: Check your composition. Is it dynamic and interesting? How does it support your story?
Remember to look at the edges of the frame and change the framing if there is anything along the edges
that would distract the viewer.
Camera Placement and Movement: Are you using a tripod? If not, are you in a stable position to shoot
handheld with the camera? Practice your motion (tilt, pan, zoom, or hand-held). If your subject will be
moving, rehearse the camera and subject motion simultaneously.

Audio: Check your sound levels. Make sure they are not too low or too high. Make sure there is no audio
interference from background noise or from your microphones. If you are using a boom pole with a shotgun
microphone, make sure it does not appear in the shot.
Shoot: Record with five-second handles at the beginning and end of your shot. If you are shooting with a
crew, when you are ready to shoot, call:
1. Camera ready
2. Sound ready
3. Roll camera (then wait several seconds)
4. Action
Make sure that the students still have the Shooting Handout. If not, re-distribute the handout so they can
follow along while they shoot. Discourage students from playing back their footage in the camcorder during
the production, as this can lead to timecode breaks. If a student watches the footage, stops the camcorder
after the footage has ended, and then starts recording again, there is likely to be a timecode break. If
students must watch their footage, teach them the technique of rewinding the tape back and stopping it
while there are still several seconds of footage remaining. This is where they should begin recording again.
VIDEO CURRICULUM: UNIT 5
Unit 5: Post-Production
Post-production is the process during which students’ stories come together. Instructors begin the
post-production process by reminding students of the program’s Technical and Creative standards, and
asking students to look at those handouts. With the help of their instructor and classmates, students should
look at the technical quality of the footage they shot during production. Footage that does not meet the
technical standards set for the students should not be used in the project. Students should also re-visit their
stories and messages, and decide if they want to make any changes from their original intentions. They
should review the story arc, make sure that their message is clear, and think about the video’s style and the
editing decisions they will make.
It’s easy for students to get lost in their footage, so encourage them to repeat this process throughout the
post-production phase. Keep checking in with them about which clips they are choosing and the edit
decisions they are making, and make sure they are clear about their story and their message.
Instructors teach students the basics of Final Cut Pro and Soundtrack so that they can import their footage,
edit their projects, and create a sound design. While students are learning new technical skills, they are
simultaneously editing their footage and shaping their stories. Students also use post-production time to
re-shoot any low-quality footage, and to get pick-up shots that will enhance their stories.
During the post-production stage, instructors model positive structures for giving and getting feedback.
Students receive feedback from mentors and peers, and are expected to give suggestions to their
classmates that display their ability to think critically about media.
After students are done with the Rough Cuts of their projects, they participate in a Rough Cut Review Panel
with invited mediamakers from the community. Panelists give students feedback on their work, and students
then have time to make revisions before their Final Cuts are due. Panelists receive copies of the rubric
(included in the assessments section), which is based on the standards set out for students at the beginning
of the course. They also receive copies of these standards so that they are clear about what instructors
expect from the students.

After they finish their videos, students participate in a Final Cut Panel Review, where the same panelists are
invited back to comment on the students’ work, and to give suggestions for what skills the students can
develop for their growth as filmmakers.
Unit 5: Introduction to the FCP Interface
Objectives
Students will understand the concept of Nonlinear Editing.
Students will know some background information on Final Cut Pro.
Students will learn about the Final Cut Pro interface.
Materials/Equipment
• Computer with Final Cut Pro for instructor and students
• A Final Cut Pro project with which to demonstrate the interface
Lesson
Nonlinear editing is the modern editing method by which digital video is edited on a computer. This method
began to appear with the introduction of digital video technology. Using nonlinear editing, footage is digitized
onto a computer, and source files are created. When using a nonlinear editing software like Final Cut Pro,
pointer files are created, and an editor can make many changes and adjustments to the footage without
affecting the source files.
Using the older method, called linear editing, film stock was physically cut and spliced together, or analog
video was recorded from one deck to another. The limitation of this method is that the editor’s cuts must be
done in order. Linear editing can be compared to using a typewriter, while nonlinear editing is more like
using a word processing program on a computer – you have the option to cut, paste, move sentences
around, and make as many changes as you would like.
Final Cut Pro
Final Cut Pro is a nonlinear editing system developed by Apple and released in 1999. It is used widely by
professional independent filmmakers and some broadcasters, and has also been used on many Hollywood
films, including Cold Mountain, Corpse Bride, Jarhead, Napoleon Dynamite, and Zodiac.
Final Cut Pro software costs $700. It is much cheaper than the AVID, another common nonlinear editor,
which consists of both hardware and software. A similar software to Final Cut Pro is Adobe’s Premier Pro,
which is used with PC computers, while Final Cut Pro is used with Macintosh computers.
There are four primary windows that make up the Final Cut Pro interface: The Browser, Viewer, Canvas,
and Timeline.
• The Browser: The Browser is where you organize all of the project elements you use when editing. This
window is where your clips are stored.
• The Viewer: the Viewer is where you view your source material and choose edit points.
• The Timeline: the Timeline is your workbench area. It is where you edit and adjust your material. It is a
graphical representation of all of the editing decisions you make.
• The Canvas:The Canvas is where you view your edited material.

Other areas of the interface:
• Tool palette: the Tool Palette is a collection of Final Cut Pro editing tools.
• Audio Meters: the audio meters display the volume level of whatever audio is playing.
Menu bar
System settings, audio/video settings and preferences can be accessed through the Final Cut Pro menu
choice.
• System settings: this is one of the two places where you can set the scratch disks for your project.
• User Preferences: here you can adjust aspects of Final Cut Pro such as pre-roll and post-roll, duration of
stills, and levels of undo.
• Audio/video settings: this is where you can adjust your device control and capture preset settings.
Take students through the rest of the menu bar. The menu bar is your control panel. Through the various
menu choices, you can perform actions such as making a new project, accessing effects, and arranging the
Final Cut Pro windows.
NET STANDARDS addressed in this lesson: 1,2
Unit 5: Logging and Capturing
Objectives:
Students will understand the log and capture window interface
Students will be able to log clips and sort media
Students will be able to capture clips
Materials/Equipment
• Computer with Final Cut Pro for instructor and students
• Make sure that every student has media to capture. Bring in media with which to do a log and capture
demo.
Lesson
For each step of the lesson, have students watch the instructor, and then follow along on their own
computers.
Connecting the deck to the computer
The first step when preparing to capture footage is connecting the deck or camera to the computer. This is
done using a firewire cable, also known as IEEE-1394-a. The smaller 4-pin connector attaches to the deck
or camera, and the larger 6-pin connector goes into the computer’s FireWire port.
Put the tape in the deck to get ready to log and capture.
Logging footage
Logging is the process of viewing your source material and dividing it into clips, which you will later use while
editing.
Looking at the log and capture window

Open the log and capture window (file/log and capture). The shortcut is command-8. The log and capture
window has two main areas: the preview area on the left, where you screen and mark your source footage,
and the logging area on the right, where you log information about your clips and make selections about
where and how you will capture footage.
Playing your footage through the log and capture window:
The transport controls are located below the image area. You can use these buttons to play, rewind, and
fast forward your footage. For a shortcut, use the J,K,L keys. J rewinds, K stops, and L plays the footage.
The space bar can also be used to stop and play the footage. If you hit the J or the L keys multiple times, the
footage will rewind or fast forward more quickly. You can also use the shuttle and jog controls (located on
either side of the transport buttons) to scrub through the footage.
Marking your footage
Use the I and O keys (or the buttons beneath the transport controls) to set an in and an outpoint for your
clip. The timecode for the inpoint and outpoint will appear in the clip in point and outpoint timecode fields.
Logging your clips:
1. Start with the logging tab. In the logging tab, you should:
2. Name your clip (keep it short!)
3. Note the reel (tape number)
4. Move on to the clip settings tab.
5. Choose what you would like to capture: just video, just audio, or both. If you are preparing to capture
narration, for example, you may want to un-check the video box so as not to use the extra hard drive space.
6. Click the toggle stereo/mono button connecting the two audible speaker icons. You can use this button
to toggle between capturing two audio channels as a stereo pair and capturing them as separate mono
channels. When the button is deselected, the audio tracks are unpaired, and the audio tracks are captured
as separate channels. Capturing audio as mono tracks is helpful when two separate microphones were used
during production. This method of capturing gives you control over the individual tracks during editing.
Toggling to the stereo option will create a connecting bracket around the two audio tracks, indicating they
will be treated as a stereo pair. This will allow you to work with both audio tracks as one clip in the timeline.
7. Move on to the capture settings tab.
8. Device control should be set to FireWire NTSC.
9. Capture/Input should be set to DV NTSC 48 kHz
10. Set your scratch disks. This tells the computer where you want your captured media to be stored
(more on that later).
11. Log a clip! Set in and outpoints and hit “log clip.” The clip will appear in your Browser.
12. You will see that there are red lines through the clips that you log. This is because these clips are
called pointer files. They do not contain any media; they just tell Final Cut Pro which sections of your tape
you would like to capture. The media files are actually created when you capture your footage. (Can make a
comparison to recipe vs. ingredients).
Sorting footage
Create bins in the Browser(File>New>Bin) and name them according to categories. Sort your footage
according to these categories (move each clip into the appropriate bin).
Capturing footage
After logging a bunch of clips, you are ready to capture. Select the clips you would like to capture and hit
“batch capture” in the logging area. Final Cut Pro will capture the media off of your tape and the red lines
through the clips will disappear.

Sometimes it is more advantageous to capture your footage all at once and then break it up into clips after it
is captured. This method can be used when you have time code breaks on your tape or if the media you are
trying to capture is very close to the beginning or end of the tape. To do this, cue the tape and hit the
“capture now” button. When the tape reaches the point where you want to end the clip, hit the Escape key.
Final Cut Pro will create a clip with the name you gave it in the logging area. You can then make subclips
out of the master clip by setting both in and out points and choosing Modify>make subclip.
Unit 5: Sorting and Reviewing Footage
Objectives
Students will understand the various stages of the editing process and start assembling their footage.
Materials/Equipment
• Computer with Final Cut Pro for instructor and students
Handouts Editing Stages (27.53 kB)
Revisiting Your Story (7.32 kB)
Lesson
• It is helpful to break the post production editing process into 3 stages: Assembling Footage, Rough Cut
and Final Cut
• Review the 3 stages of Editing (see Handout)
• At this stage, you will log and capture your footage, pinpoint your strongest images, sounds, and
interview sound bites, and re-conceptualize your final story structure
Activity
Logging and Capturing
Students will log and capture their footage and begin to organize it into bins.
To sort through interviews, students can make selects by marking where the subject adds information that is
crucial to the video message. Students should try to find the best sound bites. When logging both interview
clips and b-roll, students should consider the technical quality of the footage. Students should look at the
technical standards handout, and decide if there is any footage they need to re-shoot due to:
• Bad lighting
• Bad Audio
• Shaky camera
It is better to re-shoot then use footage that will distract the audience from the story. Students should get
feedback from the instructor and other students on the quality of their footage.
Revisiting The Story
It is easy to get lost in the production process and, in the midst of getting footage, forget the message and
thesis statement of the piece. In addition, the production process does not always go as planned.
Sometimes students will not collect all the footage they needed, or they will get footage of different
characters or events than what they expected.

For these reasons, after students finish the production process, it helps to go back to re-visit the main ideas
of their pieces.
Have each student complete the “Revisiting Your Story” worksheet to remind themselves of the message
and arc of their piece. They will re-visit their message and also make structural notes about:
• Which interview subject and what information can go in each section
• What images can go in each section
• What audio can go in each section
Students should decide what pick-up shots they need, as well as what footage they may want to re-shoot.
Unit 5: Basic Editing
Objectives
Students will be able to perform basic edits in Final Cut Pro
Materials/Equipment
• Computer with Final Cut Pro for instructor and students
• Make sure that every student has media to capture. Bring in media with which to do a log and capture
demo.
Lesson
For each step of the lesson, have students watch the instructor, and then follow along on their own
computers.
Review from logging and capturing lesson
1. Setting up deck or camera with firewire
2. Setting scratch disks
3. Identifying and organizing media files (clips, bins,sequences)
Editing In the Viewer
• To view a clip, double click on it to load it into the Viewer, or drag it into the Viewer.
• To select the portion of the clip you would like to use, hit the I and O keys to select in and out points.
• When you are done with your selection process, drag your clip to the timeline. If you want to insert the
clip between two other clips, make sure the arrow is pointing down. If you want to overwrite the clip, or
replace another clip with your new clip, make sure the arrow is pointing to the side. You can also use the
shortcuts of F9 to insert and F10 to overwrite.
Editing in the Timeline
• To select a clip in the timeline, click on it, and it becomes highlighted.
• To move a clip in the timeline, click on it and drag it to its destination. You can also use the cut and paste
function (Command0X to Cut, Command-V to paste). To move multiple clips, use the double arrows in the
toolbar.
• In order to change the duration of a clip, you can either:
• Click on the beginning or end of a clip and drag inwards or outwards, or
• Use the razor tool to cut the clip
Deleting a clip

You can delete a clip and leave a space (lifting a clip) or delete a clip and close the space (extracting a clip).
To lift a clip, press the large delete key, or backspace bar. To extract a clip, press Shift-delete (using the
large delete key) or just use the small delete key.
Snapping and Linked Selection keys
There are two buttons on the top right-hand corner of your timeline. These are the Snapping key and the
Linked selection key. They are controlled individually. To turn them on, make sure the button overlay is
green. To turn them off, press the buttons again and the green overlay will disappear. If the Snapping key is
on, it will be easier to line up clips next to each other without having them overlap. If the Linked Selection
button is on, the video and audio elements of a clip will move together.
Troubleshooting Tips
• If you are having trouble performing a task in Final Cut Pro, there are resources you can turn to for help.
Here are two of the most helpful:
• The Help Menu in Final Cut Pro. Here you can search through the index for the topic you need.
• The Apple Final Cut Pro Discussion Forum. On the Apple website, under Support/Discussions, you can
find a discussion board where Final Cut Pro users post their problems and solutions. You can search
through other people’s postings to address a troubleshooting issue, or you can make a post yourself.
Discussion
• What can you do using Final Cut Pro?
• What are Final Cut Pro’s limitations (what do you wish you could do that you can’t?)
• What more do you want to learn to do with Final Cut Pro?
NET STANDARDS addressed in this lesson: 2, 8
Unit 5: Basic Audio Editing
Objectives
Students will learn the technical skills necessary to edit audio.
Materials
• Computer with Final Cut Pro for instructor and students
• Raw editing footage to demo and work with
Lesson
The Importance of Audio:
Watch a video clip without sounds. Chose a clip many have not seen and one that has a rich or unexpected
sound design.
Questions for discussion:
• What sounds do you expect to hear in the clip?
• Visually, what story is told?
Play the clip again with sound.
• What sounds did you hear that you did not expect?
• How did sound affect the meaning of the story?

Working with Audio Clips
Editing free standing audio clips (no image) is similar to editing a visual clip:
• Drag and drop audio clips from the bin to the canvas or the timeline into the audio portion of the timeline.
The audio track can either stay locked to the video track, or can be unlinked and moved separately.
Multiple Audio Tracks:
• Just like video, you can have multiple audio elements playing at the same time, each on its own track.
• You may want each track to have the same volume, or you can adjust each audio clip so that some
sounds are softer or louder than the others (eg making the music softer than dialogue.)
Adjusting Audio Levels
• When adjusting the audio, you can change the overall level of the whole clip, or adjust a portion of the
clip. You can make these adjustments in the timeline or in the viewer.
• If the audio is stereo, make sure your change affects both clips. Double click on each separate audio clip
to make the changes and view the audio levels.
Timeline:
Adjusting the Overall Level:
• Press “Option-Command –W” to visually see the audio waveforms in the timeline. The waveform tells
your useful information- like where on the track the audio is, the highs, lows, midrange etc.
• Select Show Overlays (icon on bottom left, or View-Show Overlays). This lets you adjust the volume and
create keyframes.
• With the selection (arrow) tool, grab the pink bar, raise the bar up or down, this makes the volume louder
or softer accordingly
Adjusting a Portion of the Audio:
1. Select Show Overlays (icon on bottom left, or View-Show Overlays). This lets you adjust the volume
and create keyframes.
2. With the Pen tool, make a keyframe where you want the audio adjustment to begin and make another
keyframe where you want the adjustment to end. Move the pink bar accordingly.
Viewer:
You can make the same kinds of adjustments in the viewer
• Double click the selected audio clip
• In the viewer window, select the Audio Tab
• Adjust the Levels slider accordingly
• Use the Pen tool or the Keyframe Button to make keyframes and adjust audio levels
Note: try to keep your average sound around -12 db.
Activity
Soundscape and story:
Give each student a 30-second visual sequence with a range of audio elements in their bins. Have each
student edit 2 versions of the same visual sequence, each version with a different sound design and telling a
different story.

Screen the work and discuss how different sound arrangements influence the meaning of the piece.
Print on BAVC Letter head
• Tripod
• Sound Equipment
• Mini DV Tape
Unit 5: Editing Techniques
Objectives:
Students will learn editing techniques that will enhance storytelling skills and aesthetic assessment abilities.
Materials / Equipment
• Computer with Final Cut Pro for instructor and students
• Demo sequences for Final Cut Pro
• Demo sequences for editing activity
Handouts
Edit Activity Handout (4.61 kB)
Lesson
Pacing
When you think about the pacing of the piece, think about the way that you breathe during the day. When
something exciting happens, you breathe faster, and when you are relaxed, you breathe more slowly.
You can also think about the way that you speak. Throughout the course of a conversation, you will speak
faster at times, to communicate a great deal of information, and slower at times, to clearly illustrate a point.
Pacing in a film is the same way. The pacing, or speed of a film, should vary to match the content and the
mood.
Show media examples of differently-paced pieces.
BAVC Media Example
"Contra" by Edgardo Cervano-Soto
A haunted exploration of how the stereotypes and expectations placed upon us sometimes come from within
(3 min 30 sec).
Sound bites and b-roll
If you have captured long interview clips, sort through the clips and pull out the most relevant and most
concise phrases from the interview subjects.
Cover the cuts between interview clips with b-roll to disguise the cuts.
Demonstrate this technique to students.

Where to Cut?
General Principles
Never make a cut without a reason.
Cut on movement.
Think about how you want your audience to feel, and cut according to the emotion of the piece.
Avoid jump cuts (a shot where objects in the shot appear to jump to a new position).
Continuity editing is a style of editing which follows smooth movement. Its goal is to move the film forward
without calling attention to the editing process, therefore preserving the illusion of reality. The invisibility of
the cutting is achieved mostly with Match cuts. Match cuts match screen position, timing and direction of
movement to create an illusion of continuous movement within a sequence that actually consists of a
number of shots.
Unlike a match cut, a jump cut is a jarring cut that calls attention to itself. To avoid jump cuts, you must do at
least one of the following:
• Change the image size significantly
• Change the camera angle significantly (at least 30 degrees)
• Significantly change the subject to camera distance or the angle of the shot.
• Demonstrate jump cuts and cutting on movement.
Activity
Distribute Edit Activity Handout
You will be provided with some video and audio clips. Using the same source footage, edit together 2
distinct versions. The goal of this exercise is to explore how editing affects meaning and story. Although you
are using the same source footage, in each version you may modify the source footage to suit your needs.
Keep each version under 1 minute.
For each version be sure to explore the following editing techniques:
• Clip content – what part of the shot do you keep, what part do you cut out?
• Clip order – how does clip order affect meaning?
• Pacing- how fast or slow the clip durations are in relation to each other and on their own
• Video Transitions- straight cuts, fade, dissolve, superimposition
• Audio Transitions- straight cuts, fade,dissolve, superimposition
Unit 5: Keyframe Editing in Final Cut Pro
Objectives
Students will learn how to utilize keyframe editing for video and audio.
Materials/Equipment
• Computer with Final Cut Pro for instructor and students
• Raw editing footage to demo and work with.

Lesson
Keyframe editing lets you apply effects over time. The keyframes are the frames where you want the effect
to start or stop. To make a change over time, you must create at least 2 keyframes and then adjust the
keyframe line.
When using video, keyframes can be used to fade the video in and out, superimposing images, applying an
effect over time (like motion).
For audio, keyframes can be used to fade in and out, adjusting the volume over time.
BAVC Media Example
"20 Minutes" by Ruben Arias, Maria Tapia, Christian Lapena, Chris Vargas
There are so many things that you can do in 20 minutes... why not get tested? (1 min 33 sec).
Keyframe Uses
Video:
• Fades:
• Final Cut Pro comes with default fades for audio and video, but sometimes you want to have more
control over the fade, or fade an image or sound in the middle of a clip. With keyframes, you can do this
quickly and effectively.
•
• You only need 2 keyframes to make an adjustment, but sometimes you may want to have more in
between, to smooth out the adjustment.
•
• Superimposition of Video (laying one clip over the other):
•
• To superimpose one clip over another, you can keyframe the image and lower the opacity of the top clip.
•
• Motion:
• If you are creating a motion effect, keyframing lets you adjust the movement over time.
•
• Motion effects include: adjusting the scale over time and moving the image across the screen.
Audio:
• Levels: Using keyframes, you can adjust the volume of a sound in relation to another sound. This will be
part of your sound design.
Creating Keyframes
Keyframes can be created and adjusted in the timeline directly to the clip, or via the Final Cut Pro viewer.
• In the timeline: Make sure “Show Overlays” is selected (bottom left hand of timeline, or under the View
menu bar). Select the Pen Tool. Click on the clip where you want to add the keyframes. Adjust the line
accordingly. In the viewer: Double click the clip in question to get it in the viewer.
• For Audio: click the audio tab. Line up the playhead. Click the Keyframe button, which adds a keyframe.
Make your adjustment.
• For Video: click on the Motion or Filters tab and adjust accordingly. (The motion tab is where you can
adjust scale and opacity) Like any edit, be intentional with your use of Keyframe editing. Superimposing an

image and layering audio is an aesthetic choice. Fades in and out are types of transitions. Sometimes you
may just want to cut.Pay attention to your editing rhythm.
Unit 5: Rough Cut Review Panel

Objectives
Students will learn how to present their work to an audience.
Students will receive feedback on their work from media professionals.
Students will understand how to analyze feedback and set a plan to incorporate suggestions.
Materials/Equipment
• Computer to project pieces
• Projector
• Rubric and standards
•
Handouts
Presentation Skills (4.89 kB)
Feedback Response (4.66 kB)
Lesson
Once students have completed a Rough Cut, or basic version of their projects, a Rough Cut Review panel is
held. Media professionals are invited to the classroom to review student work and give feedback. Panelists
receive copies of the rubric (included in the assessments section), which is based on the standards set out
for students at the beginning of the course. You can also provide panelists with copies of these standards so
that they are clear about what instructors expect from the students. Knowing the standards and expectations
will help the panelists give appropriate and relevant feedback for improvement.
Discuss the Presentation Skills Handout to prepare students to present their work.
Distribute and review the Rough Cut Feedback Response Worksheet.
When panelists come in, have each student get up before her/his piece and say her/his name, project name,
and something about their project (eg why they made the piece, what their inspiration was, what they are
looking for feedback on).
Show each piece and allow time for comments and questions from the panel.
After the panel is over, students should fill out their Rough Cut Feedback Response Worksheet, which helps
them to document the feedback and make a plan for how they will respond to the feedback.
Unit 5: Effects in Final Cut Pro

Objectives:
Students will understand how to use transitions, filters, and compositing modes when editing in Final Cut
Pro.
Materials/Equipment
• Computer with Final Cut Pro for instructor and students
• Have a project ready with which to demonstrate the interface.
•
Lesson
There are three kinds of effects that can be used in Final Cut Pro:
1. A transition is placed between two clips, to create smooth movement between clips.
2. Filters are placed on the clips themselves to cause a change in the visual impact of the clip
3. Composite modes determine how one track of video will display over another track of video
BAVC Media Example
"Sorrowful Water" by Stephanie Reina
A disturbing image changes the way one girl thinks about water (2 minutes, 40 seconds).
Transitions
A transition is an effect that is placed over the tail and head of the two clips you want to create a transition
over. A simple transition (and most common) is the fade (also known as cross fade or cross dissolve).
Transitions can be accessed in 2 different places using the Final Cut Pro menus.
Under Menu > Video Transitions
Under the “effects” tab in the browser window
Two clips must be sitting side by side on the timeline for transitions to work.
Click right on the line that separates the two clips to highlight it. The computer then highlights the tail end of
the first clip and the head of the 2nd clip.
Menu>Video Transition>Dissolves>Cross Dissolve -- select. (OR) Browser window > effects tab >Video
Transition>Dissolves>Cross Dissolve
The computer automatically puts the cross dissolve on the highlighted head/tail of the clips you highlighted.
Filters
A filter is an effect that can be applied to any selected clip.
Filters can be accessed in 2 different places using the FCP menus.
Under Menu > Video Filters
Under the “effects” tab in the browser window
A clip must be highlighted before any filters can be applied.
Menu>Video Filters>Blur>Zoom Blur -- select. (OR) Browser window>effects tab >Video filters>Blur>Zoom
Blur – select
The filter is now applied to the clip.
To change the parameters of the filters, go to the viewer window, and click on the “filters” tab at the top of
the viewer window. This will allow you to see the filters applied to the clip, and tweak the settings.
Animation of the filter also takes place in this tab.
Compositing Modes

A compositing mode is a way in which you can mix multiple layers of video in video tracks stacked on top of
each other in the timeline.
Final Cut Pro has the ability to display the layers of video sitting on top of each other in different “modes”
called “transfer modes”. Depending on what transfer mode is selected, the layers of video will appear to
overlay each other and interact with each other on the timeline.
Try this:
1. Put 1 video clip in track 1.
2. Put 1 video clip in track 2 – on top of video clip 1.
3. Control-click on a clip and look at the pop-up menu.
4. See the “Compositing modes” down at the bottom? Point your mouse down there, and a new sub menu
opens up.
5. Choose one of the compositing modes (transfer modes)
6. Your 2 video clips should now appear on the canvas window together.
Depending on the different compositing modes, the two video clips will interact and display differently.
There are mathematical computations calculating the brightness and color values of each video clip and the
result of the mathematical computations results in unique way the video is displayed.
Superimposition
A specific type of compositing most people are familiar with is called superimposition. Superimposition is the
placement of one image on top of another image to create a collaged visual effect. FCP makes it easy to
superimpose however many images you desire.
1. Put 1 video clip in track 1
2. Put 1 video clip in track 2 – on top of video clip 1.
3. Make sure the Clip Overlays view is on (click the tab on the lower left hand side of the timeline of find
this option in the View Menu).
4. Lower the opacity of the top clip by lowering the line in the center of the clip.
Note: With this method you lower the overall opacity of an entire clip. To make selections that only effect a
particular section of the clip, you will need to do this with keyframes. See Keyframe editing lesson.
Unit 5: Working with Text
Objectives
Students will learn the technical skills necessary to create titles in FCP.
Materials/Equipment
• Computer with Final Cut Pro for instructor and students.
• Raw editing footage to demo and work with
Lesson
Text is most commonly used to identify people. Text can also be used as part of the visual image, for
subtitling, to identify the name of the video project, and to give credit to those who worked on the video
project.
In the browser window, click on the “effects” tab at the top of the window.

Click on “video generators” folder. This folder contains all the effects that FCP will generate from scratch
(like noise, patterns, and text).
Double-click the text effect. This will open the text effect in the viewer window.
BAVC Media Example
<embed height="175" width="200" allowfullscreen="true" allowscriptaccess="always"
type="application/x-shockwave-flash" src="http://blip.tv/play/gbRzkMcnAA"></embed>
"Four Months in the US" by Jonathan Garner
A day in the life of an immigrant from El Salvador living in the United States (3 min 40 sec).
Click and drag from the Viewer to the Timeline to place the text box on the Timeline. Double click into the
text box to load it into the viewer.
In the viewer window, click on the “controls” tab. In the controls tab, you can modify the text, changing the
words, font, size, color, and more.
Try out the other text effects. When using the “lower 3rd” text effect, the text is automatically placed in the
lower third of the screen. Other text effects (typewriter, crawl, and scroll effect) will animate (move) the text
over time.
Text can be placed on top of other video layers – this will make the text be visible on top of the video.
The text box, once placed in the timeline, can be trimmed, moved and edited like any other video clip in the
timeline. You can always go back and edit the text effect/clip by double clicking on it and bringing it back into
the viewer window.
Note: The text effect can also be accessed through the drop down menu at the lower right-hand corner of
the Viewer (the button with the “A” on it).
Unit 5: Building a Sound Design Objectives
Students will be introduced to the concept and basic elements of a sound design and audio mix.
Materials/Equipment:
• Computer with Final Cut Pro for instructor and students
• Video (Image) Sequence and Audio Media Elements for the hands-on exercise
Handouts
Building a Sound Design (8.6 kB)
Lesson
As video makers,we will also be sound designers and audio mixers.A sound designer works with the director
to create a soundtrack for the video. After determining the sound design, you need to mix the audio. As a
sound designer, it is important to understand the Sound Elements that make up a Sound Design and then
how to mix the sound design.
BAVC Media Example

"The Utters" by Jasmin Peraza
The band the Utters- who they are and why they make the music they do (3 min).
Elements of the Sound Design
● Dialogue
● Narration
● Ambient Sound
Definition and Purpose: Ambient sound consists of noises present in the environment, or “background”
sound. Ambient sounds can help create a sense of realism in a film.
Ambient sound is integral for creating a sense of space and place in a film. It also works to establish a sense
of consistent sound across scenes, and to indicate that while an edit may have occurred, no change of
space has occurred.
Sound designers add SUBTLE ambient sounds to enhance the tone of the scene, promote dramatic tension,
foreshadow, make the film space more realistic or conversely more metaphorical. Using ambient sounds is a
great way to enhance the mood, theme and message of your story- fictional or documentary.
What makes up Ambient Sounds?
Room Tone (sound of the room; a small room will “sound” different than a large auditorium)
Background and Atmospheric Noises, such as car horns, wind, rain.
Note - In addition to adding to the realism of a scene, ambient sound can be used to add emotional realism
to a sound (sound that is linked to a physical source, but also creates an emotinoal reaction. For example,
the sounds of the celing fan and the dog barking in the Cohen Brother's Blood Simple create tension and
anticipation.
Sound Effects (also known as Foley sounds)
Definition and Purpose: A sound effect is a noise associated with anything that is not dialogue. For example,
doors closing, clothes rustling, juice splashing. This is slightly different from ambiance. Ambiance is general
background noise. Sound Effects are associated with an object or person.
Note:Sound effects can be used to make a scene seem more realistic or to draw attention to an action. For
example - You are making a documentary or fictional film about someone who works at a grocert store
check-out counter. They are at the check-out counter and a customer hands them a bottle of juice. The juice
almost falls. If you want to make a dramatic moment out of this, you can add a subtle splashing sound. In
real life, the juice would not swish audibly, but in film, you can add this sound to generate a sense of drama.
Since it is rooted in the realism of the moment, it will be believable.
Music
Definition and Purpose: A musical score is meant to supplement the sound design elements, not replace it.

●
●

Musical score can add emotion and tone to a scene.
If there is a radio in the scene and music comes from it- that is music coming from a source in the
film, this is different than a musical score soundtrack.

Sound Mix
● The Sound Design determines what sounds are used. The Sound Mix determines how loud or soft
each element will be. Mix according to the effect desired.
●

For natural, realistic film, usually, during a dialogue or interview, dialogue or narration is the main
sound, and ambiance, sound effects, and music are the supporting sounds. Thus the ambiance,
sound effects and music are usually at a lower volume level than the dialogue.

●

For example, if you have 2 people having a conversation in a café where there is music playing, and
the two people are your main characters: you would record and mix the sound so: the people
conversing are the loudest (main sound), and ambient sounds of the café (including music) is lower
(supporting sound) and background to the dialogue.

●

The rules will depend on what is happening in the film, and can be broken for dramatic or emotional
effect.

●

For example, if 2 people are conversing in a café and the main character is walking past them, you
may mix the people’s conversation as part of the general ambient sound. The conversation might
get louder when the main character walks by, and softer when she/he passes. The ambiance and
sound effects will still be softer than the dialogue, but in this case, since the 2 people having a
conversation are not the main characters, the dialogue is part of the ambiance, not part of the main
sound. It is important to adjust the sound design and mix according to the perspective of the main
character.

Discussion
● Show a film with a noticeable sound design such as the opening sequence of The Conversation by
Francis Ford Coppolla, or Hoop Dreams by Steve James. Questions for discussion:
● What elements make up this sound design?
● How is the audio mixed (what sounds are louder than others), and what does this tell us about the
story?
● How does the overall sound design tell us who is the main character of the scene? How does sound
design relate to POV?
● How does the dialogue give a sense of space/place, or of story /theme…of mood?
● How do the ambient sounds give a sense of space/place, or of story/theme…of mood?
● How do the sound effects give a sense of space/place, or of story/theme…of mood?
● What elements of the sound design are the “extra” parts of the ambiance that give the scene an
extra note of interest?
Activity
● Distribute Building Your Sound Design Handout. For this activity, students should use footage from
the projects they are working on.

●

●
●
●

Students work individually. Each computer has a 30 sec - 1 minute already edited visual sequence
from projects they are working on, as well as a range of audio elements: dialogue, room tone, voice
over narration (if they have it), various ambient sounds, and various sound effects
Students will need to designate: 1) what is the story of this scene 2) what are some themes 3) what
is the mood
Students will use the audio elements to create the sounds design and then mix the audio according
to the story, theme, mood
Students present their pieces to the class, and talk about how the sound design and mix illuminates
their theme/story.

Unit 5: Soundtrack Pro
Objectives
Students will learn the technical skills necessary to add Soundtrack to their Final Cut Pro projects.
Materials/Equipment
Computer with Final Cut Pro and Soundtrack for instructor and students
Raw editing footage to demo and work with. A completed video edit would suffice as well.
Lesson
Soundtrack is a sound and music editing program that can be used with Final Cut Pro. It has thousands of
pre recorded sound effects, as well as musical loops, which you can use to lay down a music beat for the
background of your video.
Exporting your Final Cut Pro project to Soundtrack
Determine which parts of your sequence you would like to enhance with music or sound. Lasso select (draw
a selection box around) all the clips you are going to work with in Soundtrack.
Choose File "Send to à Soundtrack Pro Multitrack project." At this point, Final Cut Pro will ask you to save
the file. This will be a temporary file that Final Cut Pro will write and then load into Soundtrack pro
automatically. Choose a name for this file – like “Video for Soundtrack”.
Soundtrack opens up with your project in the timeline. Each audio track in your Final Cut Pro file is on its
own track in Soundtrack.
Accessing Files in Soundtrack
In the Soundtrack Interface, the upper left window is the viewer window (like the Final Cut Pro canvas). The
lower left window is the browser (like the Final Cut Pro browser). This is where you will access Soundtrack’s
library of sound effects and music. You can choose to browse/search through your computer to look for
other files that you have created or rendered as well. Soundtrack reads AIFF audio files.
From the lower left window, click on the “search” tab. This will open up Soundtrack’s library of sound effects.
You can sort sounds by genre, by style, or by effect. Click on any of the sounds that show up in the list
below to listen to the sound.
If you find a sound you like, click on it and drag it into the timeline portion of your Soundtrack project. Make
sure to drop this sound file off into a separate track. Making a new track is important. Layer the sounds you
would like to use in your project. Add new tracks as necessary.

Applying Effects In Soundtrack
You can apply effects to a track. The effect will affect the entire track and anything that is in it.
Click on the “effects” tab on the browser window. Choose a category of effect, and then choose an effect by
double-clicking on it.
Double-clicking an effect activates the effect for the track currently selected. Click on the “advanced” button
to edit the parameters of the effect.
Experiment with different effects by choosing different ones. If you decide you do not like the effect, simply
highlight the effect, and press “delete” on the keyboard.
You can layer multiple effects also. Just keep double-clicking on effects you want to add to your track.
If you double-click on a clip/sound file in the timeline, Soundtrack will then inform you that you are about to
edit the actual sound file, and ask if you want to make a copy (to preserve the original) or work on the
original. Choose make a copy, so that you preserve your original file for a backup.
The clip opens in the sound file editor timeline. You can highlight portions of a clip here and apply effects to
solely the highlighted portion.
The timeline has multiple tabs on it – the first tab should be your project file – and if you have chosen to edit
individual sound clips, you will have separate tabs for each individual clip.
Exporting your Sound Mix out of Soundtrack Pro
Mute the audio channels associated with the video track so that you are only exporting your new sound mix.
Choose File>Export>Export mix
Choose a file name and save it in the same location as all of your other media for the project. Call it
something like “Sound mix for project.”
Importing your Sound Mix back into Final Cut Pro
Click back into to Final Cut Pro.
Choose File "Import"
Select the file you just saved out of soundtrack
Bring the file into the timeline. It should be exactly the same length as the clips you had highlighted before
you exported from Final Cut Pro.
Unit 5: Refining your Sound Design and Mix

Objectives
Students will understand how to set audio levels, adjust panning, use audio filters, and use audio fades.
Materials
• Computer with Final Cut Pro for instructor and students

•

Media on computer to do hands on demo

Handouts
Refining Your Sound Design and Mix (6.98 kB)
Lesson
Now that your have built your sound design, it is time to make sure you mix is how you want it. In this
activity, you will use your final videos to refine your sound design and mix. Instructor can demo this on a
computer and students can follow along with practice footage.
Using Tone to Calibrate Speakers and Reference Level for Dialogue
Ever wonder what bars and tone are for? Bars calibrate your video and tone calibrates your speakers and is
a point of reference for your main sound, usually dialogue. The default for most tones is a 1 kHz tone= -12
db.
● Play your tone (most editing applications supply bars and tones- use help to find where if you do not
know).
● Adjust your speakers so this tone is the “normal” volume.
● Aim to have all your dialogue around the -12 db mark. You will build the rest of your sound design
mix around this.
Relative Levels
A sound mix is relative. Usually, if you have dialogue, ambiance, room tone, sound effects and music, when
the person is taking, the dialogue is the loudest and the other sounds supplement the atmosphere and
mood.
You should already have your sound design elements in place. Chances are you will already have a good
set for what everything sounds like and how loud or soft the different tracks are in relation to each other.
This is the step to make sure it is in audible and optimal range for DVD and TV playback.
● You want your overall combined average levels to be around -12 db.
● If need be, adjust your sound design so the average levels are around -12 db
● Note- you may still have moments of highs and lows.
Dynamic Range
The dynamic range is the range between your audio lows and peaks. You want the bulk of your sound
design at – 12 db, but if you have moments which is just ambiance, no speaking, you would not want to
boost the ambiance to -12db, that would make is unrealistically loud. Instead, you mark this as a low.
Conversely, if you have a plane crash, it is an effect that may be louder than the bulk of the sound. This may
be your peak.
Make sure your peaks (loudest sound) no higher than -6db, and have your lows no lower than -20 db. If the
peaks are too low, you will not hear them, if they are too high, the sound will distort when played back or
when exported.
Rules:
●
●
●
●
●

High Peaks: no higher than -6 db
Bulk of your program: -12 db
Lows: no lower than -20 d
A dynamic range helps can allow you to have subtle impacts and affect with audio.
Pan

●

Each audio element and track has the ability to be panned to the left speaker, to the right speaker
and center (both speakers).
Most programs are “center” which means the sound plays equally on left and right speakers. If you are not
playing with the sound pan, go through your program and make sure EACH clip is Pan to center.
If you want to play with the creation of space and perspective with sound, you may want to play with pan.
You can be subtle or drastic.
Example: scene in the kitchen, shot of the sink. A sprinkler sound starts to come from the backyard, a dog
barks.
● You can either have the sprinkler and dog ambiance panned to center, or maybe the sprinkler is
slightly left, and the dog barking is slightly right.
● IN FCP, Pan 0= centered
● Pan + 1= right
● Pan -1 = left
● So, Pan +68 is more to the right, some to the left. Only use Panning if it adds to the story and mood.
Be subtle, be intentional.
● Filters for Dialogue
To smooth our audio pops, use the Vocal DePopper Filter
To lesson sibilance (sssss), use the Vocal DeEsser Filter
● Audio Fades
● Use audio fades to transition one audio clip to another. This is a small, subtle trick that will make all
the difference.
In FCP: Put your cursor in between the 2 audio clips, OPTION CLICK- select Audio Cross Fade + 3db. This
adds a subtle cross fade that will transition one audio clip to the next.
When fading audio in from the head or tail of a program, choose the audio cross fade 0 db.
You can also do this manually using audio keyframe editing.
Choose pen tool, make a keyframe on the audio track where you want it to start the fade
Make another keyframe where you want to end the fade.
Fade it down or up accordingly.
Listen
●
●
●

Listen to your video paying attention to the audio.
Does it sound like you want it to sound?
Headphones are fine for editing, but headphones do not accurately reflect what a mix will sound like
on a TV etc. Before you export your project to tape/DVD, be sure to listen to your project on a few
different sources. This will give you a sense of what your sound mix will sound like for your
viewer.For example, listen to your project on: built in speaker on computer, external speakers, TV
monitor etc.

Unit 5: Finishing the Project
Objectives:
Students will learn the basic finishing steps to follow before outputting their projects to tape.

Students will be able to adjust audio levels to the proper decibels.
Students will be able to perform color correction on their pieces.
Students will be able to create credits for their pieces.
Students will understand when and how to use the deinterlace filter.
Students will understand title and action safe, and be able to adjust picture and text accordingly.
Lesson
Before the pieces are considered complete, there are several steps we need to take:
Audio
●

●

●
●
●

Check the audio levels: Students should use the audio meters or the audio mix window layout to
view audio levels. The audio mix window layout is more detailed, because it allows you to see all of
the audio track levels separately and combined. The audio levels should fall between –12db and
–10db. If the levels are higher, and especially if they are peaking, or hitting the red area in the
meters, they need to be lowered. The audio will be distorted if it is not lowered. If the levels fall too
far below –12db, they need to be raised. The audio will not be properly audible if not raised.
Students should use the pen tool to create keyframes to adjust the audio levels. They should make
sure that interview audio and voiceover can be heard over music, sound effects, and ambient noise
(unless this is part of their sound design).
Check for audio inconsistencies: Listen for pops, umms, ands, and swallowing
Check that the pan is set to 0
Listen to the final audio mix. Headphones are good to start with, but they do not accurately reflect
what a mix will sound like when broadcast. Listen to the project in the external speakers, and on an
external monitor or televison.

Color correction
Use the 3-way color correction tool found in the effects menu (Effects>Video filters>3-way color corrector).
Which color is the circle leaning towards? If the color balance is off, move the circle towards the opposite
color.
Gaps and Transitions
Make sure there are no unintentional Black gaps. Review your edits to make sure they flow. Review and
check your transitions (are they appropriate, is the pacing good?)
Credits
Students should make sure their credits and text fall within the title-safe region of the screen. If they are not,
they could be cut off by smaller televisions. Check the spelling in the credits. Students should make sure
they are including everyone who they need to thank. They should think about who helped them with their
project, who they interviewed, and who appears on screen. They should also include any associations with
programs or grants that are needed. (eg Made In Association with BAVC’s YouthLink Program.
Deinterlacing stills

A video camera camera scans odd lines separately from the even lines, which results in two fields of video.
These fields are combined to make up one frame. The two fields are slightly different. Therefore, when a still
frame is pulled from video, the picture is likely to flicker. To solve this problem, the deinterlace filter has to be
applied. The De-Interlace filter works by removing either the upper (odd) or lower (even) field of information
from any interlaced video. With only one field remaining, Final Cut Pro interpolates the remaining information
to recreate a whole image. To apply the deinterlace filter:
1. double click on the clip to be deinterlaced
2. go to the effects menu/video filters/video/de-interlace
Gaps
Make sure there are no unintentional black gaps
Transitions
Check that transitions are well-placed and appropriate
Render
Render your sequence to prepare for viewing and output.
View
Watch piece on a monitor. Look for color accuracy and visual flickering. Make sure no part of the picture
gets cut off.
Naming
Name the final version of your project. Example: Name_class_FINAL_title_date
VIDEO CURRICULUM: UNIT 6
Unit 6: Telling the Community Stories
In the Advanced level of the YouthLink class we focus on taking students’ skills to the next level. As students
prepare to create their Short Documentaries, we emphasize the development of more sophisticated
storytelling, and discuss techniques that students can use to tell other people’s stories.
Community Organizations
Students work with community members and experts to think of story ideas, do research, find subjects, and
shape their stories.
Character-Based Storytelling
Students are encouraged to find subjects whose stories can illustrate the issues they would like to explore.
For example, if students would like to address the concept of war, we encourage them to find a subject who
just enlisted in the army, or whose family member is serving in the war.
Style
Students may choose the style for their piece, whether conventional documentary or more experimental, as
long as they have a clear idea of the impact that they want to have on the audience.
Unit 6: Short Documentary Projects

In Advanced YouthLink, students move from Personal Narratives to longer-form documentary shorts on
topics relevant to the filmmakers’ lives and communities. Students work in groups of 2-3 on these 5-8 minute
Short Documentaries, covering topics such as youth prisons or neighborhood pollution.
Students brainstorm topics that they would like to focus on, and are then assigned groups based on similar
interests. Once groups are formed, instructors spend time talking with the groups about the best ways to
function when working with other people. Instructors acknowledge the difficulty of working in a group, and
talk about conflict resolution, roles and responsibility, and communication.
We encourage students to research their topics by meeting with community organizations and experts who
can inform and shape their projects. This collaboration is also important in helping students build ties to their
local community. We also continue to emphasize our program standards and expect higher production
levels as students create these advanced projects.
All students develop plans for how they want their pieces to reach their audiences and the kind of impact
they want their media to have on their audiences. Students watch a variety of social issue documentaries
and PSA’s and discuss key media literacy concepts such as point of view, style, message, and symbolism.
Students can choose a variety of different forms for distribution; they can develop the piece for a classroom
setting, community screenings, or for specific festivals or broadcast venues.
Unit 6: Exploring Documentary Filmmaking
Objectives
Students will understand that there are various methods a filmmaker can use to tell another person’s story
Students will understand that a documentary can be made with many different styles.
Lesson
There are many styles and approaches to Documentary Filmmaking. In this lesson we have compiled a list
of documentaries that range in their styles and approaches. For each film, use the SCMAA and story arc
worksheets to aid in the film analysis.
Traditional Techniques
The following examples are considered “traditional “ style documentaries, using talking head interviews with
b-roll, in which the interview subjects provide stories and information that are presented as facts and
evidence in support of the themes being explored in the documentary.
BAVC Media Example
"Neglected" by Karla J. Gallardo and Antonette Santiago
Why are minorities not covered in national news when they go missing? Neglected explores the way media
portrays missing people and the lack of coverage in national news of minorities (7 min 10 sec).
VIDEO CURRICULUM: UNIT 7
Unit 7: Advanced Pre-Production Skills

One way that these Short Documentaries vary from the more personal projects is that we are encouraging
students to expand their horizons and explore the stories of other people and communities.
After students brainstorm socially-relevant topics, instructors encourage students to move further into these
topics by conducting research, whether internet-based or in person. The Using Research for Your Video
(5.36 kB) Handout can help to guide students through this process. The purpose of this research is to help
students gain some historical context for their topics, and to determine how their topic is currently relevant.
Exploring current discussions and conflicts that relate to the topic can help students find the relevant stories
within their topics.
Once students have completed their research, they prepare to pitch their topics to the class as they did in
the Beginning Level class. The revised Pitch Worksheet for the Advanced class can help assist students in
communicating what they learned from their research, and how their pieces would contribute to discussions
around current issues.

Unit 7: Working with Community Organizations
Objectives
Students will understand how to work with members of the community to think of story ideas, do research,
find subjects, and shape their stories.
Lesson
Partnering with community organizations can be a useful tool both for brainstorming topics and as part of the
research process.
Brainstorming
If the students are working on a group issue, find an individual or representative from an organization who
can speak to that issue. For example, if the group is working on pieces about Youth Rights, have a lawyer
who specializes in this field come to talk to the group. Students can then use the issues brought up through
the lecture as possible story ideas.
Researching Community Members
When students are engaged in projects about community issues, research is an important component to
their projects. Part of this research involves identifying individuals in various communities who may be:
* potential subjects for the story
* experts about the issue the student is working on
BAVC Media Example
"The Apollos" by Jazmin Jones and Nick Parker
The 1981 Oakland Tech High School senior class fought to make MLK day a nationally recognized holiday.
The story of the Apollos is a story of those who reach beyond the stars. Created by Jazmin Jones and Nick
Parker (6 minutes).
Contacting Community Members

As the students engage in research, have them contact the individuals and/or organizations that fit into
these categories. Prepare the student to make the phone call. Have them write a script with bullet points
such as:
* Who they are and the program they belong to
* What they are working on
* What they are looking for
* Potential dates and times to meet
Potential subjects for the story
Set up an interview with this person to see if they would be an appropriate and engaging character. In
addition, some change or event that could be documented on video should be happening in this person’s
life.
Record the interview so that the student has the footage if s/he decides to use this person as a character.
Experts in the field
Have the student call authorities on their subject to set up a lecture and a possible interview.
If the expert comes in to give a lecture, it could be a learning experience for the whole class.
Activity
Show students several examples of short documentaries that were made in the YouthLink program. Discuss
the storytelling methods and styles used. Discuss how the videos are telling community stories and
partnering with community organizations and/or members.
VIDEO CURRICULUM: UNIT 8
Unit 8: Advanced Production Skills
By the time students reach the Advanced level class, they should understand the technical skills necessary
to use a camera and shoot a scene. In the Advanced class, we teach the new skill of how to set up artificial
lights, and how to use those lights as they set up an interview or a scene. We also expect students to be
more self-sufficient in both the technical aspects of their production, as well as their abilities to act as a
director or other crew member. We give them more independence as they operate equipment and plan their
shots, and expect them to know the tasks required of each of the crew members in the production. The
Production Role cards can remind students about their tasks as they act independently in a shoot.
Unit 8: Lighting
Objectives
Students will learn how to handle lighting equipment and basic lighting techniques.
Materials / Equipment
* Light kits (4 lights and light stands)
* TV/VCR cart
* Camera
* Tripod

Lesson
Assign students setting-up roles:
* Setting up stands and lights
* Putting barn doors on the lights
* Laying out accessories (C-47’s, gloves, diffusion, gels)
* Putting the chimera together
* Setting up camera, tripod, and TV/VCR cart
Ask a student to sit in a chair as an interview subject, and set up the lights around the subject.
BAVC Media Example
"Dear Addy" by Christina Chin
While writing a letter to a friend, a girl discovers her need to change as her thoughts unravel onto the page
(3 min 56 sec).
Why do we light?
* To see a picture
* To create a mood
* To highlight a person or object
* To mimic a time of day
* To create depth
Safety
* Yell “striking,” or simply, “light going on” if you are going to turn a light on
* To avoid tripping on cords, don’t run cords across the room, or tape the cords to the floor using gaffer’s
tape
* Use gloves to touch the lights, as lights get hot
* Don’t touch bulbs with hands – the oils on our fingers can cause them to explode
* Let lights cool before putting them away
* Don’t let gels/diffusion touch lights
The 3-Point Lighting Technique
The Three Point Lighting Technique is a standard method used in visual media such as video, film, still
photography and computer-generated imagery. The technique uses three lights, called the key light, fill light
and back light.
THE KEY LIGHT
The key light is the main, or strongest light in the scene.
How to set up the key light: When we use artificial light, we try to recreate the real world. The key light
should imitate the sun. Put it at a 45-degree angle, angled down. If the key light is too high, it creates harsh
nose and eye socket shadows that look like mid-day sunlight. If the key light is too low (below eye level), it
creates a sinister effect. Use up to about 650-watts for an enclosed room.

The key light should be placed 45-degrees left or right from the camera. If the light is too close to the
camera, the subject will appear even and flat. As the key light is moved further to the side, the shadows
become more pronounced. When the light moves behind the subject, that is called backlighting and the
subject is in shadow.
Turn off all of the overhead lights in the room. Turn on the key light.
How close to place the key light to the subject:
Every light source (sun, sky, lamp, candle, etc.) has its own character or quality. For example, a picture of a
person on a sunny day looks different from the same person under an overcast sky. The difference in light
quality affects the kinds of shadows cast on the subject. The light can be described as hard or soft. The
hardness or softness depends on the distance from the subject and the size of the light source.
The closer the light is to the subject, the stronger or harder the light will be. If you move the key light back 1
foot, that will decrease the strength by 2x. If the key light is too strong on the subject, you can either move
the lights away from the subject to lower the light, or put a diffuser filter over the light. This will cut down on
the amount of light. You can use diffusion or the chimera (softbox) to make the light softer (scatter the light).
You can also use an umbrella. Take off the barn doors to mount the umbrella.
Camera Settings: Adjust the exposure of the camera, and use the TV monitor to see how it looks. Expose
for the face of the interview subject, and make sure to keep in mind the color of the skin. Always use the
manual exposure setting, never the automatic setting. Expose to see shadows, as this gives depth. White
balance the camera in the light. Make sure that the light is hitting the white paper.
Use Barn doors to focus the light.
Turn the Key light on and off to see how it looks.
THE FILL LIGHT
The fill light is the light that fills in the shadows created by the key light. You do not want to fill the shadows
in all the way, or you will lose depth.
How to set up the fill light:
The fill light should also be placed 45-degrees off of the subject, on the other side of the key light.
With the key light still on, turn on the fill light.
The ratio of the key light to the fill light should be about 2:1 or 3:1. That means that the strength of the key
light should be 2 or 3 times the strength of the fill light.
Make sure the key light is not throwing light onto something else besides the subject. You can use the barn
doors so the light is just on the subject.
If the fill light is too strong on the subject, you can either move the lights away from the subject to lower the
light, or put a diffuser filter over the light. This will cut down on the amount of light. You can use diffusion or

the chimera (softbox) to make the light softer (scatter the light). You can also use an umbrella. Take off the
barn doors to mount the umbrella.
Turn on and off the fill light to see if it is filling in the shadows and if the ratio works.
THE BACK LIGHT
The back light is the light that separates the subject from the background.
How to set up the back light:
The back light is placed above and behind the subject. It is meant to give a rim of light around the head and
shoulders. Turn off the other lights to see just the rim of light.You can back the light up or diffuse it if it is too
strong. Camera Settings: Re-adjustthe exposure of the camera, and use the TV monitor to see how it looks.
Reminder: always use the manual exposure setting, never the automatic setting.
THE BACKGROUND LIGHT
If you want your background to be visible, or you want to highlight it, you can light the background.
How to set up the background light:
Place a light facing the background. You can narrow the barn doors to create a swath of light. You can also
use gels to colorize it.
Gels and Diffusers
Colored gels can be placed over the lights to cool down (blue) or warm up (orange) the picture. There are
many different colors of gels available, as well as strengths, or thicknesses, of gels. Be aware the stronger
the gel, the less light will go through the gel.
Diffuser filters placed over the lights can be used to soften the harshness of a light. There are different
grades (strengths) of diffusers that are available. The greater the strength of the diffuser, the less amount of
light that will go through (and the softer the light will look).
Activity
Set up a 3 point (or 4 point) light set. Try to follow the same kind of lighting pattern as explained in this
lesson plan.
Notes for using outdoor light: Make sure to white balance, as sunlight has a different color temperature from
indoor tungsten light Can use the flex fill or a white board as a fill to reflect the sunlight and fill in the
shadows.
Unit 8: Production Roles
Objectives
* Students will understand the responsibilities of each person on a production crew
* Students will be able to act with more independence on a shoot
Handouts
Production Cards - Camera Person (4.13 kB)

Production Cards - Interviewer (4.01 kB)
Production Cards - Lighting Person (4.12 kB)
Production Cards - Sound Person (4.15 kB)
Lesson
When going out on a shoot, the Production Role cards can assist the student director in assigning roles to
the crew. They can then help each student remember the tasks that she/he should perform. In addition,
students should make their own deliberations about shoot details (eg which microphone to use, where to
place lights, and where to place the subject.
Camera Person
* Is there a tape in the camera? Is it cued?
* Have you recorded pre-roll?
* Have you focused the camera?
* What does your shot composition look like? Does it support your story? Is there nose room and head
room? Are you following the rule of thirds?
* Is your shot steady?
* Did you record post-roll?
Sound Person
* Have you plugged the microphone into the camera?
* Have you checked the audio settings on the camera?
* Have you checked your audio levels on the camera?
* Do you have the headphones on?
* Do you hear any background noise? (eg refrigerator)
* Is anything rubbing on the microphone?
* Is the boom pole out of the shot?
Lighting Person
* Is there enough light on your subject?
* Do you need to use a reflector or fill light to fill in the shadows?
* What should the exposure be? Is it on manual?
* What is the color temperature of the light? Have you checked the white balance?
Interviewer
* Do you have your questions in front of you?
* Is your subject in a stable, non-moving chair?
* Have you offered your subject a drink?
* Is the background appropriate to the topic?
* Are you asking open-ended questions?
* Is the subject repeating the question in her/his answer?
* Are you listening and asking follow-up questions?
* Have you gotten a release?

Net Standards addressed in this lesson: 2
VIDEO CURRICULUM: UNIT 9
Unit 9: Making an Impact with Your Media
Youth media plays a unique role in our world, giving us windows into the minds of young people and their
perspectives on their lives, their histories, and their futures. As students create their issue-based Short
Documentaries, we ask them to think about whom they want to speak to and what kind of impact they would
like their pieces to have.
One of our emphases in the Advanced level class is to prepare students to distribute their work. These
pieces can screen in countless venues – students’ videos show in film festivals, are screened at meetings
and conferences, contribute to curriculum in schools, and are be streamed on the web.
Instructors teach students how to create a distribution plan to target events and festivals to which they would
like to submit their work. Students learn how to output their projects to mini DV, as well as how to create a
DVD of their work using DVD Studio Pro. Students write Director’s Statements, film synopses, and
filmmaker bios, and pull still images from their projects, all of which can be used when submitting to film
festivals. Because the internet plays an increasingly important role in the distribution of independent media,
we also teach students how to compress their videos for Youth Media sites such as Listen Up and Uth TV,
video sharing sites such as You Tube, and social networking sites such as My Space. After students are
finished learning how to create the components of a distribution kit, students create their own distribution kits
that they can use as they submit their work.
Unit 9: Distribution Strategies
Objectives
Students will make a Distribution Plan and assemble their Distribution Kits.
Handouts
Distribution Kit Checklist (4.26 kB)
Lesson
Once you have made your video, the next step is to get it out to the world! You can submit your video to a
film festival, find a local organization who could benefit from your video, screen at community events or
school settings or upload your video on line…or all of the above!
Distribution Plan
The first step is to make a Distribution Plan. Ask yourself:
* What is the message/theme in my video?
* Who is the audience? Who would benefit from seeing my video?
* What are festivals, venues, organizations, school events that show videos like mine?
Traditionally, video makers send their video to film festivals or upload the video to on line websites.
However, if you have a message and particular impact you want to make, consider finding an organization
that is also trying to make change and team up with them. Your video could help them with the work that

they do, and at the same time, you gain exposure. Similarly, if you are in school, talk to staff at the school
and see if you can loop your video in the school library so other youth can see the work. If you want your
video to show online, create a website or myspace page and try to promote your video that way. Here are
some websites where you can showcase your video:
* www.youtube.com
* www.listenup.org
* www.googlevideo.com
* www.myspace.com
If you want to send your video to film festivals, search for festivals on line. One useful site is
www.listenup.org. Once you have selected a few festivals, go to their websites and make sure your work fits
in with their screening history.
When you submit your video to the outside world, you must have subject releases and permission to use
any music or art in the video that you did not create yourself.
Once you have your Distribution Plan, it is time to get your Distribution Kit ready.
Distribution Kit
Whether you are submitting your video to a film festival or uploading it online, it is customary to also send a
kit which includes relevant information about your video. When sending your video out, always add this kit,
even if they don’t ask for it, as it is your chance to give them as much information about your video as
possible.
A Distribution Kit includes:
* Your Video (on DVD, mini DV or compressed file for online distribution)
* One Sheet and Director’s Statement (see future lessons for explanation)
* Video Stills
In order to submit your video, you need to move it from the Final Cut Pro file on your computer to an external
format. You can export your video to many different formats, such as mini DV, DVD, and a file you can
upload to the internet. See future lessons for instructions.
Make sure your video is clearly labeled with the following information:
* Title of Piece
* Directed by
* Total Running Time
* Year Made
* Contact Information
When you are submitting your video to a film festival, they often ask you to fill out a submission form. Make
sure you fill it out completely.
If there is a submission fee, you may consider writing an email asking for a fee waiver.

Activity
Make a Distribution Plan for your video.
NET STANDARDS addressed in this lesson: 5
Unit 9: Exporting from Final Cut Pro to Mini DV
Objectives
Students will learn how to export their project to tape with the purpose of screening or submission.
Materials/Equipment
* Mini DV tape for each student
Lesson
In order to screen or submit your video, you need to move it from the Final Cut Pro file on your computer to
an external format. Mini DV is a common exhibition format.
Exporting your project to Mini DV
1. Go the File menu and select “Print to Video.”
2. Check the boxes for the components you would like to include before your project starts. It is helpful to
include, color bars, black space, and a countdown.
3. Test that the audio is working by clicking on the Tone Level Preview button. Make sure the audio level is
set to –12db.
4. Select Print In to Out or Entire Media (either way, Final Cut Pro will output the entire project, unless you
have specific in and out points set on your sequence.)
5. Select the amount of trailer, or black space, that you would like to place at the end of the tape; 30-60
seconds is a good duration.
6. Press record and play on the video recorder and click ok to begin your output.
Activity
Export your project from Final Cut Pro to Mini DV.
NET STANDARDS addressed in this lesson: 10
Unit 9: Preparing Files for DVD
Objectives
Students will learn how to compress their project file in order to create a DVD.
Materials/Equipment
* DVD for each student
Lesson
In order to create a DVD, you must compress your files into a format that DVD Studio Pro can read. The
format of the files imported into DVD Studio Pro must be:

* For video: MPEG file format or a still image file (eg JPEG or TIFF)
* For audio: PCM (AIFF and WAV) or AC-3 files
A Final Cut Pro project can be exported through Compressor to create these file types.
Compressing your project using the Compressor Software
1. Choose File>Export>Using Compressor
2. Navigate to the Batch Window
3. Select the setting you would like to use for output. A good setting to use is Best Quality 90 minutes 4:3.
4. Choose MPEG2, which is the file format for video
5. Choose either AIFF or Dolby sound for the music file
6. Choose a destination to save your files.
7. Click on the submit button.
Activity
Export your files using Compressor.
Unit 9: Creating a DVD in DVD Studio Pro
Objectives
Students will learn how to use the DVD Studio Pro software to create a DVD.
Materials/Equipment
* Use compressor to export compressed versions of the video and audio files of each student's project.
Use the 90-minute high quality setting. Save the files on each machine they will be using.
Lesson
Have students follow along with the lecture on their computers.
What is DVD Studio Pro?
DVD Studio Pro is a DVD authoring a burning software. Students can use DVD Studio Pro to burn DVD's of
their work. A DVD-5, which is a single-sided, single layer DVD, can hold 4.7 GB of media (1-2 hours).
DVD Studio Pro Interface
Use F2 (or Window/Configurations/Extended) to see access Extended setup.
The Assets window displays all of the files that you will bring into DVD Studio Pro. It is like the Browser in
Final Cut Pro. Also similarly, none of these files contain media - they are just pointer files. The media files
are the actual compressed files that were saved on the students' hard drives.
Each separate project you import will become a track in your DVD project.
In the Track Editor, you can view the content of your tracks in a Timeline.
The Outline tab displays all of the menus and tracks.
The Project window Menu tab displays the menu that you create.

The Project window Viewer tab displays any asset that you click on.
The Palette displays menu templates.
The Inspector is used to change the properties of the items in your project.
Have everyone save and name their DVD SP projects.
Building and Burning a DVD
There are 6 steps involved in building and burning a DVD:
1. Compressing the project files - already done, but show them how to do it
2. Importing the files into DVD Studio Pro
3. Assembling the DVD menu
4. Linking the files
5. Building and Burning the DVD
6. Labeling the DVD
1. Compressing the files
Refer to the previous lesson to learn how to export the Final Cut Pro file through compressor. If you do not
have compressor, you can export a Quicktime file from your Final Cut Pro file and import that directly into
DVD Studio Pro.
2. Importing the files into DVD Studio Pro
in the Assets tab, use the import button to import the appropriate files into your project. This would include
video files, corresponding audio files, any still images you want to use, and any music files you may want to
use to add music to the menu.
3. Assembling the DVD menu
Name the menu and track in the outline tab or in the inspector.
Choose a template from the Templates Palette and modify it in the following ways:
Add the title of your video. Can go to the menu bar and use Format/fonts to change the size and font.
Delete buttons that you don't want from the Palette.
Name your buttons and fill in the text in the Button Inspector (style tab).
Bring a still or moving image into the Drop Zones (drag and drop).
More on buttons:
In the Advanced tab in the Button Inspector, go to the Navigation menus and set them according to how you
want the viewer to navigate the menu.
In the Colors tab in the Button Inspector, set the normal, activated, and selected colors and opacities. Use
the simulator to test the colors.
You can also use the simulator to view any motion sequences you dropped into the drop zones in the menu.

In the Transitions tab in the Button inspector, choose the transition you would like to use to move from the
button to the piece that will play when the button is pressed.
Adding music: Drag the music file to the menu and hold it over the menu until you see the option: editor: set
audio. Release the mouse. Music will now play while your menu is on the screen.
4. Connecting the button to the track
In the Button Inspector, find the target drop down menu and associate it with the appropriate track.
Set the track's end jump back to the main menu: Go into the outline tab of the assets window. Click on your
track. In the Track inspector, find the end jump drop down menu and set the end jump back to your main
menu.
Use the simulator to test the links.
5. Building and burning the DVD
Hit the Build/Format Button in the menu bar to build and burn your DVD. Building a DVD means that DVD
Studio Pro will create a Video_TS, or Video Title Set folder. This folder contains the finished DVD Project.
a. Choose the location where your Build folder will be saved.
b. Hit the "Build and Burn" button. The DVD burner slot will open. Insert the DVD.
c. DVD Studio Pro will create a Video_TS folder and will then burn your DVD.
If, later, you want to change something in the project, and then want to burn another DVD, go back to the
DVD Studio Pro project and hit format. DVD Studio Pro will burn a new DVD that includes your changes.
6. Labeling the DVD
When labeling your DVD, include the following information:
∙ Title of the video
∙ Your Name
∙ TRT (Total Running Time)
∙ Year Made
∙ Distribution Contact Information
Activity
Create a DVD of your project.
NET STANDARDS addressed in this lesson: 10
Unit 9: Exporting Video Files for Online Distribution
Objectives
Students will learn how to export video files so that they can distribute their videos on the internet
Lesson
Now that you have finished your video, it is time to share it with the world. Traditionally, distribution has
meant sending your videos to film festivals or to local venues, but in our current times, the internet is a
growing resource for distribution. There are online festivals as well as websites that showcase videos and
websites where you can add videos to your homepage.
To post your video online, you need a compressed version of your video, and there are many compression
options available. Final Cut has a preset export setting for ipods, which also works for web upload. Since
this is simple and relatively hassle free method, we will use this.

Compressing your video for the web
In Final Cut Pro, open your completed project.
1. In the File Menu, go to Export – Quicktime Conversion
2. In the Format tab, select iPod
3. Save this file to an appropriate location
The iPod conversion converts your video to a m4v file which is small enough to be uploaded to the internet.
If you are having problems, change the file extension (m4v) to mp4. You can check your new file in
Quicktime Player to make sure it plays correctly.
Activity
Have students export their projects and upload their pieces to an online distribution site. Some options
include:
www.listenup.org
www.googlevideo.com
www.youtube.com
NET STANDARDS addressed in this lesson: 5, 7
Unit 9: One Sheets and Director Statements
Objectives
Students will learn how to make a One Sheet and Director’s Statement which details relevant information
about the video. This is part of the Press Kit.
Handouts
What to Include in a One Sheet (4.1 kB)
One Sheet and Director Statement Examples (5.26 kB)
Lesson
A major component of distribution is presenting your video to the world in the best way possible. A onesheet and director’s statement is a piece of paper that contains crucial information about your video. This is
a quick reference sheet for the person viewing your work. Film festivals and venues will often use this
information in the program guides they make.
What to Include in the One Sheet
* Title of Piece
* Directed by
* Total Running Time/Year Made
* Contact Information
* 2 line synopsis of piece
* 2 line bio
* Director’s Statement (Optional)

The first section of the one sheet contains technical and contact information about the video. The second
section gives information about the video and director. The one-sheet is an important supplement to your
video, as your motivation and intent influence the way that people interpret your video. While there are many
styles and approaches, be sure in the end that your sentences and ideas are clear and concise. Also, don’t
forget to check your spelling!
Pass out the handouts for examples of one sheets and Director’s Statements, as well as writing prompts.
Activity
The contents of Synopses, Bios, and Director’s Statements can vary. Discuss the following examples and
analyze what information is included. After a couple of examples led by the instructor, have the class
actively lead the analysis.
Synopsis
The synopsis is a description of the video. When writing your synopsis, think about what will get people
interested in viewing the piece. You may also include some reference to the style of the video. Sometimes
festivals and venues want a short synopsis, but in some cases, a longer version is also acceptable.
2-3 SENTENCE SYNOPSES
Synopsis for "Life and the Streets" by Lupe Paredes
Growing up in a gang active barrio is not easy. Three young adults share what they have gone through.
Analysis: In this example the filmmaker makes a general statement and then a statement about what is
explored in the video.
Synopsis for "My Familia" by Ruben Ruiz
My Familia is a portrait of my family, their struggles with poverty and how they survived. True Story.
Analysis: In this example, the title of the piece is referenced, what the video is about and a catch phrase at
the end to give the synopsis flare.
SHORT AND LONG SYNOPSES
Synopses for "By the By" by Kirthi Nath
2-3 line Synopsis: In "By the By," Nath invites the viewer into a sensuous audiovisual landscape of moments
detailing the inner-belly of nostalgia and experiences of distance and proximities.
Analysis: In this example the title of the piece and filmmaker is referenced, as well as a description of the
film in terms of themes and aesthetic approach.
In "By the By," Kirthi Nath continues to explore questions of the self, memory and desire and how this
cross-sects place and the sensual experience of a moment. Nath layers visual footage taken over years of
traveling in India and Nepal, waiting in airports along the way and witnessing various shenanigans outside
her mother's old Long Beach apartment with quotes found on the sidewalks of San Francisco and by
inspiring women artists. Adding to this textural expression is a rich sound design drawn from sounds
recorded in Africa and India, and messages left on answering machines.
Analysis: In this longer example the title of the piece and filmmaker is referenced, as well as a poetic
description of the film in terms of themes and aesthetic approach. Additionally, details about the film and its
production are incorporated.

Synopsis for "History and Memory: For Akiko and Takeshige" by Rea Tajiri
2-3 sentence synopsis: Rea Tajiri's "History and Memory: For Akiko and Takeshig" is an exploration of the
Japanese-American experience through media reports, Hollywood clips and the maker's mother's personal
memories of her internment during World War II.
Source: 
http://mediaartists.org/content.php?sec=artist&sub=detail&artist_id=227
Longer Synopsis: This moving exploration of personal and cultural memory juxtaposes Hollywood images of
Japanese Americans and World War II propaganda with stories from the videomaker’s family. Ruminating
on the difficult nature of representing the past, the artist blends interviews, memorabilia, a pilgrimage to the
camp where her mother was interned, and the story of her father, who had been drafted pre-Pearl Harbor
and returned to find his family’s house removed from its site. A haunting testament to the Japanese
American experience.
Source: 
http://www.wmm.com/filmcatalog/pages/c111.shtml
Analysis: In this longer example the film is described in terms of themes and aesthetic approaches. Details
about the film themes and socially relevant issues, history and culture are expanded upon.
Bios
What do you want people to know about you? People often write about themselves in the third person,
sometimes in the first person. You can tell people your age, your general interests, what inspires you, what
you think about media and how you want to make an impact. A 2-3 sentence bio is usually sufficient.
Nick Parker Bio
Nick Parker is a youth who want so to increase common knowledge and promote awareness through the art
of film.
Analysis: What do we learn about the filmmaker? His name and how he wants to make a social impact with
film.
Jazmin Jones Bio
Jazmin Jones is high school student interested in all forms of video media. She currently supports any film
with something positive to say.
Analysis: What do we learn about the filmmaker? Her name and the kind of media she is interested in.
Christina Chin Bio
Christina Chin is an aspiring filmmaker who hopes to one day work on a fabulous musical extravaganza as
well as a Jane Austen adaptation.
Analysis: What do we learn about the filmmaker? Her name and what her future creative aspirations are.
Giuliano Morse Bio
Giuliano was born and raised in San Francisco in a traditional Italian family. His films are inspired by the
things around him- his family, background and values.

Analysis: What do we learn about the filmmaker? His name, where he grew up, his family context and what
inspires him.
Edgardo Cervano-Soto Bio
Edgardo Cervano-Soto is from Richmond, Ca. He likes drawing, writing, and swimming. He looks forward to
creating more films.
Analysis: What do we learn about the filmmaker? His name, where he lives and his interests outside of
media making.
Director’s Statements (Optional)
A Director’s Statement is not always necessary, but it supplements the information in your one-sheet and
gives the viewer further insight into your video. You can write about the impact you want your video to have,
how the style and artistic decisions support your story, and what inspired you. Writing a Director’s Statement
will also help prepare you to talk about your video publicly, because it gives you practice thinking about why
you made your video and what your intent is.
Statements Specific to a Video Project
It is common for filmmakers to base their Director’s Statements around a particular project. This allows your
audience to share in your thoughts about your video.
General Statements
Once you are more advanced and have made a few videos, you will be at a point where you can articulate
your artistic style, talk about themes you like explore, and express your filmmaking vision. Writing a general
statement will help you clarify your understanding of your own art. It is good practice to make a general
statement every year or so, to be able to understand your trajectory of artistic growth. Students should start
out by writing a Director’s Statement specific to their project, and then write a general statement once they
have made multiple pieces.
Director’s Statement – Project Specific
Director’s Statement from Jazmin Jones and Nick Parker, Directors of The Apollos
The Apollos is about the struggle of a high school senior class to pass a bill making MLK’s birthday a
nationally recognized holiday. The idea behind The Apollos came from us wanting to increase youth
involvement in social issues, so we decided to use a powerful example. By combining the different
interviews into one powerful story we created a non-traditional hybrid interview style to shows the union of
new and old ideas working toward the same goal. Hopefully today’s youth will learn from The Apollos and
flex that metaphoric bicep in today’s adult run society. We want youth around the world to know they too are
world citizens and have a voice, USE IT.
Analysis: This statement tells us what the video is about, what inspired the topic, comments about aesthetic
approach, intended audience and impact.
Director’s Statement – General
Director's Statement from Jazmin Jones, Co-Director of The Apollos
I am interested in all forms of media. I believe that by blending different forms of art such as audio, visuals,
storytelling, etc. you can create a more powerful piece than by using one art form alone. Each project I make
is different, and I've found that each person takes something different out them. Our current culture, and my
generation, is prone to listening to video media. I want to create films that have something positive to say.

The last film I made (The Apollos) has been accepted in many film festivals. I feel honored by the
acceptances and am very excited that the film will reach many audiences and share a story they may not
have known before. Before I made this last film, I remember seeing a film, I Promise Africa. This film
touched me, It challenged me. I remember it still. I feel passionate for film and the world I live in. My hope is
to carry inspiration to others.
Analysis: The videomaker shares her thoughts about media making and consumption as well as her
personal vision and intent with media making. She also gives us insight into what inspired her.
Activity
Have students re-watch their videos and create their own one-sheets and Director’s Statements.

Unit 9: Pulling Still Images from your Video
Objectives
Students will learn how to export still images that they can use as part of their Distribution Kit.
Lesson
When submitting your video to festivals and/or internet sites, you should include video stills along with your
one-sheet and Director’s Statement. These stills will serve as visual representations of your work, and may
be used in festival program guides or posted on a festival or distribution website. You can also use your still
image for your personal video webpage or myspace page.
Images saved a 72dpi can be used for websites, and images saved at 300dpi can be used for print
materials. When uploading videos to a website, use the 72 dpi image. When sending your video for a festival
or to an event, burn a cd with the 72 dpi and 300 dpi stills so they can use the stills for their program guide
and website. Don’t forget to clearly label your cd with the name of your video project, your name, the content
on the cd (still images) and your contact information.
Selecting the Image
What are 2 images that are compelling and represent your video?
Pulling the Still
1. Put your curser on the desired image
2. Go to File>Export>using Quicktime Conversion
3. Select “still image” for the format type at the bottom of the screen
4. Click on the options button and choose jpeg as your file format
5. Click on the next options button and se the quality to “best quality.”
6. Name your file and save.
Preparing the Image
In Photoshop
1. Open the image
2. From the Filters menu, select Video – De-Interlace

You need to deinterlace your still because a video still contains 2 fields per frame. When you pull a still from
a video you need to take away one of the fields or the image will appear “blurry”.
1. Save the image and label it appropriately with the words 72 dpi in the name. This image will be a 72 dpi
because that is video resolution. To provide a 300 dpi image, you will bump up the resolution in Photoshop.
2. Open the 72 dpi image (that has already been de-interlaced)
3. Go to the Image Menu and select Image Size.
4. In the resolution tab, type 300 dpi.
5. Save the image and label it appropriately with the words 300 dpi in the name.
6. Burn the stills onto a CD for distribution purposes. Label the CD with your name, and the names and
resolutions of the files on the CD.
Activity
Have Students select and prepare stills from their video, and then assemble a distribution kit, complete with
DVD, One-sheet, Director’s Statement, and stills. Have students select one festival or event from their
Distribution Plan and submit their work.

